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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens Aktiengesellschaft. The remaining trademarks in 
this publication may be trademarks whose use by third parties for their own purposes could violate the rights of 
the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions.
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Validity 1
Validity

This update is valid for the following products:
• STEP 7 Basic V18
• STEP 7 Professional V18
• WinCC Basic V18
• WinCC Comfort V18
• WinCC Advanced V18
• WinCC Professional V18
• WinCC Unified V18
• TIA Portal Openness V18

Note
If you modify your system after installing the update with the product DVD, you will have to 
perform the update again.

Readme
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Improvements in STEP 7 2
2.1 Improvements in Update 5

This update contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Migrating TIA Portal Classic projects
The integrated migration of Classic projects (*.s7p, *.mcp, *.hmi) is no longer supported as of 
TIA Portal V18 Update 5. 
Use the migration tool to convert the initial project to a migration file that can be read by 
TIA Portal (*.am18). Following conversion, this file is transferred to the target system and 
migrated in TIA Portal.
You can find the migration tool in the "Support" directory on the installation DVD of the TIA 
Portal. Alternatively, it is available for download from the Siemens Industry Online Support.

Software units: Changed downloading behavior (S7-1500)
The downloading behavior of software units was changed so that you can now download 
individual software units more easily independently of other software units.
When downloading software units a check is carried out whether further software units have 
to be downloaded as well to ensure the consistency of the ONLINE project. 
Previously two software units had to be downloaded together when the following conditions 
were fulfilled:
1. There is a relation between the software units. The relation is contained both in the offline as 

well as in the ONLINE project.
2. At the software units on the relations target side an interface-relevant change at the 

published programming elements was performed since the last download. 
The check of the actual usage of changed programming elements is new in V18.00.01.05. 
If changed programming elements in the dependent software unit are not used, this does 
not have to be included in the download. Software units can now be downloaded more 
independently of each other through the additional check.

Readme
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The following table shows the changed download behavior in detail:

Scenario Checking during download Reaction
Software unit on relation source side 
was selected for download

Check in offline program: 
Does the software unit to be loaded use 
interface-relevant changed, published 
programming elements from the soft‐
ware unit on the relation target side?

If check is met:
Software unit on relation target side 
must be included in the download scope.
If check is not met:
The selected software unit can be loaded 
independently.

Software unit on the relation target side 
was selected for downloading

Check in the ONLINE program:
Does the software unit on the relation 
source side use interface-relevant 
changed, published programming ele‐
ments from the software unit to be 
downloaded?

If check is met:
Software unit on relation source side 
must be included in the download scope.
If check is not met:
The selected software unit can be loaded 
independently.

Notes: 
• The new check of the downloading dependencies can only be performed once you have 

downloaded your project once with V18.00.01.05. After an upgrade to TIA Portal 
V18.00.01.05 we recommend downloading once with the function "Download to device > 
Software (all)". 

• The new check of the downloading dependencies applies for the function "Download to 
device > Software (only changes)".  
The old downloading behavior still applies for the function "Download to device > Software 
(with related software units)". Only the first two conditions are checked and possibly a larger 
number of programming elements included in the downloading scope. 

Handing over data blocks as actual parameters
Data blocks which contain both retentive as well as non-retentive elements, can not be handed 
over to a formal parameter of the data types STRUCT during the block call. A syntax error was not 
always reported in older versions. Now a syntax error is output in all programming languages.

2.2 Improvements in Update 4
This update contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Improvements in STEP 7
2.2 Improvements in Update 4

Readme
10 Readme, 10/2024, A5E52423187-AE



CA certificates of projects from TIA Portal < V17 are not accepted when connecting from/to 
S7-1500 CPUs

Secure communication from/to S7-1500 CPUs with firmware V3.1 cannot be established if CA 
certificates are used and the project in use was created with TIA Portal < V17. These CA 
certificates are not accepted because the "KeyUsage" property is missing and the property 
"BasicContraints" is not set as "critical".
In this case, follow these steps:
1. Create a new CA certificate with TIA Portal V18.

– To do this, open the certificate manager under "Project tree > Security functions".
– Call the context menu command "Create" in the table of the certificate authority (CA). 

The "Create certificate" dialog opens.
– Make the desired settings for the new CA certificate and click "OK".

2. Export the newly created CA certificate as a certificate file (PKCS12) with the file extension 
".p12".

3. Delete the newly created CA certificate, otherwise it will not be possible to use it in the next 
action step. 

4. Replace the original CA certificate with the exported CA certificate. 
– To do this, open the certificate manager under "Project tree > Security functions".
– Call the "Replace" command in the context menu of the original CA certificate.
– In your file system, select the previously exported certificate file with the file extension 

".p12" and click "Open".
All derived device certificates are automatically digitally signed with the renewed CA 
certificate. 

5. Then download all affected devices with the updated certificates. 

Namespaces in libraries
All versions of a type must have the same namespace. It is therefore not possible to create a new 
version of a type and assign it a new namespace. Instead, create a new type with a new 
namespace.

2.3 Improvements in Update 3
This update contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Improvements in STEP 7
2.3 Improvements in Update 3
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2.4 Improvements in Update 2
This update contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Length limitation for names and namespaces in software units (S7-1500)
The namespace and the name of a program element must not exceed the total length of 125 
characters. The separators (.) are included.
Previously, separate length limitations of 60 characters each applied to the namespace and 
60 characters to the name of the element.

Behavior when exporting objects in the Version Control Interface (VCI)
As of V18 Update 2, SIMATIC ML files exported with Version Control Interface (VCI) no longer 
display default values. If a change was made to a default value, an entry is written to the 
exported XML file. This can lead to changes in the behavior when comparing the existing files 
with the objects in VCI. Run the export again to get the new export format.

Security note on know-how-protected blocks and projects
When protecting blocks, note that full password protection is not provided until you archive the 
project.
After archiving, only the archived project no longer contains any unprotected blocks. 
Optimization of project data during archiving removes older, possibly unprotected project 
content.
If you want to distribute protected building blocks, only pass on the archived project, or copy 
the building blocks to a new global library.

2.5 Improvements in Update 1
This update contains the following improvements and changes:

Working with the TIA Portal
Stability when working with the TIA Portal has been improved, partly based on the feedback 
from returned crash reports.

Port and service name for TIA Administrator V2
TIA Administrator V2 listens at port "8890".

Improvements in STEP 7
2.5 Improvements in Update 1
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The service of the TIA Administrator V2 that belongs to the process "node.exe" is 
"SiemensAwb".
TIA Administrator V1 keeps the previous port "8888" and service name "SiemensTiaAdmin".

Service name for TIA Portal project server
The name of the service associated with the process "Siemens.Automation.Portal.Server(.exe)" 
has been changed from "V[version number]prjsrv" to "prjsrv".

Improved search function in the information system
The search function has been improved with synonym recognition. When you search for a term, 
defined synonyms of the term are now also found.
Synonym recognition is available in English, German and Chinese.

Improvements in STEP 7
2.5 Improvements in Update 1
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Improvements in STEP 7
2.5 Improvements in Update 1
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Improvements in WinCC 3
3.1 Important notes

This page contains important information about product properties

Character sets after Windows 10 update
Since Windows 10 Update Version 1809, Windows allows the installation of character sets either 
with administrator rights for each user (command "Install for all users" in the shortcut menu) or 
for specific users. In order to use WinCC character sets without restrictions and load them onto 
an HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

Changing the installation directory
If you had installed the simulation with an earlier version of WinCC, you can no longer change 
the installation directory during installation.

Access to array variables via OPC UA
If you use WinCC Runtime Advanced as OPC UA server, reading array tags is only supported when 
the "OPC UA Server Array index range access" setting is activated.
Writing array variables is only possible if the OPC UA client supports the "Write array elements 
without IndexRange" setting.

Integrated Web server: Communication via OPC UA
If the error message 8010_0000 occurs during the communication of the integrated Web server 
via OPC UA, check the length of the transmitted arrays. If arrays are to be transmitted via OPC UA, 
the array may only have a maximum of 20 elements.

PLC code view
The performance of the PLC code view when opening the S7-GRAPH overview depends, among 
other things, on the number of jumps to be displayed.

Detaching a faceplate from the faceplate type
The "Detach faceplate from faceplate type" option is only available for selection if the faceplate 
type uses more than one screen object.

Readme
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Search and replace with regular expressions
In the "Search and replace" palette, the "Use regular expressions" additional option is disabled.

3.2 Engineering

3.2.1 Improvements in Update 5
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

HTML browser
HTML files are correctly displayed in the browser.

3.2.2 Improvements in Update 4 
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Events at faceplates
In the editor of the faceplate type the connection between contained objects and events of the 
"Interface" list is displayed correctly in the "Events" tab.

3.2.3 Improvements in Update 3
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Improvements in WinCC
3.2 Engineering
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HTML browser
In WinCC Runtime Professional, the display of the "HTML browser" object in the engineering 
system has been improved.

3.2.4 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Faceplates
When objects are grouped into faceplates, the group gets its own interface. Any existing 
interfaces of the individual objects are lost.

3.2.5 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

3.3 Runtime Advanced

3.3.1 Important notes
This page contains important information about product properties

Character sets after Windows 10 update
Since Windows 10 Update Version 1809, Windows allows the installation of character sets either 
with administrator rights for each user (command "Install for all users" in the context menu) or 
for specific users. In order to use WinCC character sets without restrictions and load them onto 
an HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

Improvements in WinCC
3.3 Runtime Advanced
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SIMATIC S7-1500 Software Controller V30.0
The update introduces version V30.0 of the SIMATIC S7-1500 Software Controller.
An integrated HMI connection is only possible with Software Controllers up to version 29.1.
As of Software Controller V30.0, integrated HMI connections are not supported and cannot 
be configured.
When the version of a configured Software Controllers is upgraded to V30.0, an Advanced 
Runtime existing on the same station is removed. 

Changing the IP address of a device through back-up or DHCP server
Network settings
Please note that the network settings of a device such as the IP address can be overwritten if 
a backup of the device with different network settings is loaded onto the device, e.g. via the 
"Restore" function or by inserting a system memory card that has been used for "automatic 
backup".

Dynamic addressing through DHCP
If the IP address is assigned dynamically to a device through a DHCP server, this may result, 
for example, after a temporary shutdown of the device, in the project being recompiled or 
reloaded with modified network settings.
Use reserved, permanently assigned IP addresses as far as possible.

3.3.2 Improvements in Update 5
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

3.3.3 Improvements in Update 4 
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.3 Runtime Advanced
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3.3.4 Improvements in Update 3
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

PDF view
The toolbar in the PDF display is displayed correctly.

3.3.5 Improvements in Update 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Faceplates
When objects are grouped into faceplates, the group gets its own interface. Any existing 
interfaces of the individual objects are lost.

3.3.6 Improvements in Update 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.3 Runtime Advanced
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3.4 Runtime Professional

3.4.1 Validity

Validity
This update is valid for the following products:
• WinCC Runtime Professional V18

Note
You need to reboot the WinCC Web Configurator after installing the update.

Cybersecurity information
Siemens provides products and solutions with industrial cybersecurity functions that support 
the secure operation of plants, systems, machines, and networks.
In order to protect plants, systems, machines, and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
cybersecurity concept. Siemens’ products and solutions only form one element of such a 
concept.
It is the responsibility of the customers to prevent unauthorized access to their plants, 
systems, machines and networks. Such systems, machines and components should only be 
connected to an enterprise network or the Internet if and to the extent such a connection 
is necessary and only when appropriate protective measures (e.g. firewalls and/or network 
segmentation) are in place.
For more information on protective industrial cybersecurity measures for implementation, 
visit:
https://www.siemens.com/global/en/products/automation/topic-areas/industrial-
cybersecurity.html (https://www.siemens.com/global/en/products/automation/topic-areas/
industrial-cybersecurity.html) 
Siemens' products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are 
outdated or no longer supported may increase the customer’s exposure to cyber threats. 
To stay informed about product updates at all times, subscribe to the Siemens Industrial 
Cybersecurity RSS Feed under:
https://new.siemens.com/global/en/products/services/cert.html (https://new.siemens.com/
global/en/products/services/cert.html) 

Improvements in WinCC
3.4 Runtime Professional
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3.4.2 Important notes
This page contains important information about product properties

Note
If Runtime is operated in kiosk mode with disabled shortcut keys in full-screen, you should 
disable access to online help in the ActiveX controls, otherwise the operator can gain access to 
the operating system.

Character sets after Windows 10 update
Since Windows 10 Update Version 1809, Windows allows to install character sets either with 
Administrator rights for each user (command "Install for all users" in the shortcut menu) or for 
specific users. In order to use WinCC character sets without restrictions and load them onto an 
HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

Deactivating NTLMv1 and SMBv1
The NTLMv1 and SMBv1 protocols can be disabled. Deactivating the protocols does not have any 
effect on the operation of WinCC Runtime Professional.

Note
Security risk from NTLMv1 and SMBv1
Use of the NTLMv1 and SMBv1 protocols is a significant security risk. Communications in the 
network could be compromised, for example, by man-in-the-middle attacks.

Depending on the operating system, the procedure for deactivating the protocols can be 
different.

Scripts on the WebUX or WebNavigator server
C or VBS scripts triggered by services such as Global Script, Alarm Logging, or Tag Logging are 
independent of Graphics Runtime and therefore run only on WebUX or WebNavigator servers.
• Any output of such functions, e.g. via printf() or HMIRuntime.Trace(), is not visible in the 

script diagnostics window on a WebUX or WebNavigator client. 
• All access to Graphics Runtime from such functions are always made to the local Graphics 

Runtime of the WinCC server.

Improvements in WinCC
3.4 Runtime Professional
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Installing "Siemens.Automation.WinCC Project CA" certificate on a WebUX/Web Navigator Client
To install the "Siemens.Automation.WinCC Project CA" certificate on a WebUX or Web Navigator 
Client, follow these steps: 
1. Export the "Siemens.Automation.WinCC Project CA" certificate in the "Base-64-encoded 

X.509 (.CER)" format from the WebUX or WebNavigator Server, for example by using the 
WinCC Certificate Manager.

2. On the WebUX/Web Navigator Client in the Windows Start menu select the command "Run" 
and enter "certlm.msc" to start the certificate manager of the local device.

3. Under "Certificates - Local computer > Trustworthy root certification bodies" select the folder 
"Certificates".

4. Open the shortcut menu of the folder and select "All tasks > Import…".
5. Import the certificate exported from the server.

Automatic logout on multi-touch devices
To ensure that a configured automatic logout works on devices with a multi-touch screen even 
when using SIMATIC Logon V1.6 Update 3, configure any function, for example, to set a bit of a 
tag to the "Touched" event of the screen. This resets the logoff time timer when the screen is 
touched.

Recipes
To ensure optimal performance of the recipe view in Runtime, it is recommended to create no 
more than 500 recipe queries or 500 recipe query elements.
If, when importing data records, it is determined that a data record ID to be imported already 
exists in the user log, an error message is generated. An entry for the error message is stored 
in the log file "UALogFile.txt". The data records whose IDs do not exist in the user log are 
added as new data records.

Using the "GetTagDateTime" function
To ensure that the correct values are returned when using the "GetTagDateTime" function, the 
"GetTagDoubleWait" function should additionally be executed before the first call.
Alternatively, use the "GetTagDateTimeWait" function.

3.4.3 Important changes in behavior

WinCC Professional OPC UA: Updating the OpenSSL version
As of WinCC Professional V17 Update 7, OpenSSL 3.0 is used for WinCC OPC UA.
If the OPC UA certificate of an HMI device with WinCC was created before V17 Update 7, it 
becomes incompatible through the device upgrade. Recreate the certificate.
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HMI device uses a self-signed certificate
1. Delete the certificate from the certificate store before upgrading the HMI device:

– OPC UA client certificate:
C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_V11\WinCC\OPC\UAClient\PKI

– OPC UA server certificate:
C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_V11\WinCC\OPC\UAServer\PKI 

Delete both the DER file and the PFX file.
2. Upgrade the HMI device.

The certificate is automatically created and installed.
3. Trust the certificate on the communication partners.
HMI device uses CA-based certificate created with third-party tool
1. Delete the third-party root certificate and the OPC UA application certificate from the 

certificate store before upgrading the HMI device:
– OPC UA client certificate:

C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_V11\WinCC\OPC\UAClient\PKI

– OPC UA server certificate:
C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_V11\WinCC\OPC\UAServer\PKI 

Delete both the DER file and the PFX file of the application certificate.
2. Upgrade the HMI device.
3. Upgrade the third-party tool to a version that uses OpenSSL 3.0.
4. Recreate the OPC UA certificate of the HMI device with the tool.
5. To install the certificate on the HMI device, copy it to the certificate store on the HMI device:

– OPC UA client certificate:
C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_V11\WinCC\OPC\UAClient\PKI

– OPC UA server certificate:
C:\Program Files (x86)\Siemens\Automation\SCADA-
RT_V11\WinCC\OPC\UAServer\PKI 

If the communication partner already trusts the root certificate of the certificate authority, it 
automatically also trusts the newly created OPC UA certificate of the HMI device.

3.4.4 Improvements in Update 5
This update contains the following improvements and changes:
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Stability and performance
Stability and performance have been improved based on feedback, among other things.

HTML browser
The HTML files are correctly displayed in the browser.

3.4.5 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
Stability and performance have been improved based on feedback, among other things.

Passwords
The character % can be used in a password.

Loading fully
The routines for fully loading projects has been improved.

Object focusing in Runtime
The logic of the object focusing after, for example, a mouse-click has been improved.

Recipe view
The display of the recipe view in Runtime has been improved. The columns show the configured 
behavior, for example, in particular with regard to visibility and sortability.

Screen window
When using multiple screens the display of screen windows takes place in accordance with the 
configuration. 

HTML browser
Also files that are stored in a location other than the "Download" project folder are displayed 
correctly in the "Browser" control.

WString tags in a user data type
Tags of the data type WString which are used in a user data type are displayed fully in Runtime. 
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Communication
The setup of the connection to the control system is possible, even if the name of the access 
point is shorter than 3 characters.

WebUX
For WebUX the login via Simatic Logon is possible, even if an invalid login attempt took place 
beforehand.

3.4.6 Improvements in Runtime Update 3 
This update contains the following improvements and changes:

Stability and performance
Stability and performance have been improved based on feedback, among other things.

Gauge and slider in faceplates
When the "Gauge" and "Slider" objects are used in a faceplate and text-based properties are 
supplied with values via the interface, both static and dynamic values are output correctly in 
runtime.

Communication with GuardLogix and ControlLogix
During communication with GuardLogix and ControlLogix via Allen-Bradley Ethernet/IP, tags of 
data types UDInt, UInt and USInt are also displayed correctly in WinCC Runtime.

3.4.7 Improvements in Runtime Update 2
This update contains the following improvements and changes:

WebUX
Stability and performance have been improved.
The display and dynamization of screens and screen objects has been improved.
The configuration dialog has been improved.

WebNavigator
Stability and performance have been improved.
The WinCC WebBrowserControl (Chromium) has been improved.
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Diagnostics
The system diagnostics display has been improved.
Channel diagnostics has been improved.

3.4.8 WinCC Certificate Manager

3.4.8.1 Introduction 
WinCC Runtime Professional supports the use of CA-based HMI certificates (CA = Certificate 
Authority). You provide these certificates with the "WinCC Certificate Manager" application.

Note
No external certificate authority
Issuance, distribution and installation of these certificates requires the use of the Certificate 
Manager. 
The use of an external certificate authority or an intermediate certificate authority is not 
supported.

Functionality of the WinCC Certificate Manager
• Central creation and management of certificates in the network
• Creation of a certificate authority with:

– Private key
– Public key (root certificate) 
– CRL file (CRL = Certificate Revocation List)

• Issuance of the application certificates of the HMI devices
• Renewing existing certificates
• Encrypted export of the application certificates as well as the root certificate for manual 

distribution to HMI devices
• Encrypted import and installation of the certificates on the HMI devices
• Encrypted export and import of the root certificate, CRL file, and private key, as well as all 

device certificates for data backup and restore.
• Export of the root certificate and its CRL file for distribution to external communication 

partners of the HMI device
• Export of an updated CRL file for distribution to the HMI devices and their external 

communication partners
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Available application certificates
With WinCC Certificate Manager you can create the following CA-based application certificates 
for WinCC Professional HMI devices:
• WebUX | WebNavigator certificate 
• OPC UA server certificate
• OPC UA client certificate
• OPC UA tag import certificate 

3.4.8.2 Making certificates available

Procedure
The procedure for providing the certificates as well as the operation of the Certificate Manager 
interface is largely the same for WinCC Professional and WinCC Unified. Follow the steps 
described in the WinCC Unified Certificate Manager user help.
You can find more information on the WinCC Unified Certificate Manager in Entry ID 
109813308 in the Siemens Industry Online Support Portal in the "SIMATIC HMI WinCC 
Unified Engineering V18" help under "Runtime and Simulation > Certificate Manager".

Restrictions and special features 
Deviating from the procedures and facts described in the user help for WinCC Unified Certificate 
Manager, the following applies to WinCC Professional:

Generation of application certificates
You can only generate the application certificates listed in section AUTOHOTSPOT.

Device binding of the certificates
When adding a device to the certificate authority, you specify what information is used to 
bind its application certificates to the device. 
In the "New device" dialog, you have the option of entering multiple IP addresses in the "IP" 
field. Use ";" as separator.

Note
Enter the IP address of the device (own IP) as the first IP address.

The IP addresses are added to the Subject Alternative Name of the certificate.
Example: An HMI device is an OPC UA server and has a NAT router. The OPC UA clients 
communicate with the server via the NAT router. Enter the private IP address of the 
OPC UA Server HMI device (own IP) and the public IP address in Certificate Manager.

Distribution and installation of the application certificates
To distribute the certificate configuration of the certificate authority to the HMI devices and to 
install the certificate configuration of an HMI device on the device, follow the steps described 
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in the WinCC Unified Certificate Manager user help for export, import and installation on 
Unified PCs.
For more information, see Entry ID 109813308 in the Siemens Industry Online Support 
Portal in the "SIMATIC HMI WinCC Unified Engineering V18" help under "Runtime and 
Simulation > Certificate Manager > Export, Import and Installation for Unified PCs".

Binding of the WebUX | WebNavigator certificate to the Runtime web page
If the Runtime Server web page has already been set up and you install the WebUX 
| WebNavigator certificate on the HMI device with Certificate Manager, the installation 
automatically binds the certificate to the Runtime web page.
If the website has not been set up yet, the binding cannot be performed successfully. 
Certificate Manager logs this via an entry in the "Output" area.

Installation of the root certificate on the WebUX/WebNavigator clients
To display Runtime in a WebUX/WebNavigator client, the root certificate of the WebUX/
WebNavigator application certificate must be installed as trustworthy on the client. It is not 
necessary to install the root certificate manually in the following cases:

Runtime access Display via Requirement
Local
 

WinCCViewerRT 
or 
Internet Explorer

The WebNavigator certificate has been installed on 
the HMI device with Certificate Manager.

Chrome or Edge The WebUX certificate has been installed on the HMI 
device with Certificate Manager.

Remote WinCCViewerRT 
or 
Internet Explorer

The WebNavigator client device is also an HMI device. 
It has the same certificate authority as the HMI device, 
whose Runtime it displays in WinCCViewerRT or In‐
ternet Explorer. 
The server HMI device has a WebNavigator certificate.
On both HMI devices the certificate configuration of 
the respective device has been installed with Certifi‐
cate Manager.

Chrome or Edge The device of the WebUX client is also an HMI device. 
It has the same certificate authority as the HMI device, 
whose Runtime it displays in Chrome or Edge. 
The server HMI device has a WebUX certificate.
On both HMI devices the certificate configuration of 
the respective device has been installed with Certifi‐
cate Manager.

In other cases, install the root certificate manually on the WebNavigator clients and WebUX 
clients. Follow the steps described in section AUTOHOTSPOT.

3.4.8.3 Installing a root certificate manually
This section describes how to install the root certificate in order to display Runtime Professional 
in a WebUX/WebNavigator client.
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Requirements
• On the certificate authority device:

– A certificate authority has been created with WinCC Certificate Manager.
– The Runtime Server HMI device has been added to the certificate authority and a WebUX 

| WebNavigator certificate has been added to the HMI device. 
– The certificate configuration of the HMI device has been exported. 

• On the HMI device:
The certificate configuration of the HMI device has been installed with WinCC Certificate 
Manager.

• On the WebUX/WebNavigator client devices:
– To display Runtime in a browser, the desired browser must be installed on the 

WebUX client device. 
– To display Runtime in Internet Explorer, the WebNavigator client must also be installed on 

the WebUX client device.
– To display Runtime with WinCCViewerRT, the WebNavigator client must be installed on 

the WebNavigator client device.

Procedure
1. Export the root certificate on the certificate authority device using Certificate Manager. 

Follow the steps described in the WinCC Unified Certificate Manager user help.
2. Transfer the exported root certificate file to a storage location that the WebUX/

WebNavigator client device can access, such as a network folder or external storage medium. 
Follow the steps described in the WinCC Unified Certificate Manager user help.
Your further procedure depends on which client you are using.

3. Edge and Chrome as the WebUX client:
– Double-click the root certificate file on the WebUX client device.

The root certificate is opened with the Windows standard form.
– Select "Install Certificate".
– In the certificate import wizard, select "Local Machine" as the storage location, "Trusted 

Root Certification Authority" as the certificate store.
– Start the import.
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4. Browser with its own certificate store as a WebUX client:
Manually install the root certificate on the WebUX client device in the certificate store of the 
browser. Follow the steps described in the user help of the browser.
For Firefox, for example, follow these steps:
– In Firefox, click "Display certificates" under "Settings > Privacy & Security" under 

"Certificates".
– In the "Certificate Management" window, select the "Certification authorities" tab.
– Click "Import" and select the root certificate file.
– In the window that opens, select the option "This certificate can identify websites" and 

confirm your selection.
5. Internet Explorer or WinCCViewerRT as WebNavigator client:

On the WebNavigator client device, manually copy the root certificate file in the Windows 
system certificate store to the trusted certificate authorities folder. 

Result
The next time the client tries to connect the WebUX/WebNavigator client with Runtime, the 
client trusts the root certificate and thus also the WebUX certificate or the WebNavigator 
certificate from Runtime. 
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3.4.8.4 Structure of the user interface

Overview
The interface of WinCC Unified Certificate Manager has the following structure:

① Menu bar
② Toolbar
③ Work area with the "CA configuration" and "Installed certificates" tabs
④ "Details" area (fixed)

The "Details" area shows you detailed information about the certificate selected in the work area.
⑤ Information bar
⑥ "Output" area (hidden)

The "Output" area logs operator control actions.

You can customize the display of the interface to suit your needs. Follow the steps described 
in the WinCC Unified Certificate Manager user help.
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Menu bar
Menu Description
"File > Exit" Closes Certificate Manager.
"View" Configure which Certificate Manager interface elements you see.

You can open or close the following interface elements:
• "Output" area
• "Details" area
• "CA configuration" tab
• "Installed certificates" tab

"Help" "About Certificate Manager"
Opens a dialog with information about the installed software version.

Toolbar
Button  

To change the user interface language

3.5 Panels

3.5.1 Improvements in Update 5
This update contains the following improvements and changes:

Visual Studio 2010 Redistributables
The EoL versions of Visual Studio 2010 Redistributables have been removed from this update.
It is thus no longer possible to download a project to HMI SIMATIC Basic Panels V11 or V12 or 
to simulate the HMI SIMATIC Basic Panels V11 to V15.
If HMI SIMATIC Basic Panels of the named versions are still needed, you must install the 
missing Visual Studio Redistributables manually. Please note that an EoL version can have 
security vulnerabilities. You are solely responsible if you install such as version.

3.5.2 Improvements in Update 1
This update contains the following improvements and changes:
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Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Improvements in WinCC
3.5 Panels

Readme
Readme, 10/2024, A5E52423187-AE 33



Improvements in WinCC
3.5 Panels

Readme
34 Readme, 10/2024, A5E52423187-AE



Improvements in WinCC Unified 4
4.1 Validity

Validity
This update is valid for the following products:
• WinCC Unified V18
• WinCC Unified Runtime V18

Cybersecurity information
Siemens provides products and solutions with industrial cybersecurity functions that support 
the secure operation of plants, systems, machines, and networks.
In order to protect plants, systems, machines, and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
cybersecurity concept. Siemens’ products and solutions only form one element of such a 
concept.
It is the responsibility of the customers to prevent unauthorized access to their plants, 
systems, machines and networks. Such systems, machines and components should only be 
connected to an enterprise network or the Internet if and to the extent such a connection 
is necessary and only when appropriate protective measures (e.g. firewalls and/or network 
segmentation) are in place.
For more information on protective industrial cybersecurity measures for implementation, 
visit:
https://www.siemens.com/global/en/products/automation/topic-areas/industrial-
cybersecurity.html (https://www.siemens.com/global/en/products/automation/topic-areas/
industrial-cybersecurity.html) 
Siemens' products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are 
outdated or no longer supported may increase the customer’s exposure to cyber threats. 
To stay informed about product updates at all times, subscribe to the Siemens Industrial 
Cybersecurity RSS Feed under:
https://new.siemens.com/global/en/products/services/cert.html (https://new.siemens.com/
global/en/products/services/cert.html) 

4.2 Important notes
This page contains important information about product properties.
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Device versions with V18 Update 3
The new device version 18.0.0.3 has been introduced for Unified PC and Unified Panels in order 
to be able to use the new functions which were introduced with V18 Update 3. Please note the 
following:
• If you open a project on a computer on which TIA Portal V18 is installed without an update, 

you cannot edit the devices contained there with device version 18.0.0.3.
• If you switch from a device version 18.0.0.3 to a previous device version, you can no longer 

use new functions.
• The functions introduced with V18 Update 3 are also supported by higher device versions.
Unified PC
• Install Update 3 for WinCC Unified Runtime on the target device before loading a device with 

device version 18.0.0.3.
• If you load a device with the configured device version 18.0.0.0 onto a Runtime with a higher 

device version, warnings are displayed pointing out the different versions. To avoid 
incompatibilities, the projected device version should correspond to the actual Runtime 
version.

• If your project contains the "GRAPH overview" or "PLC code display" screen objects, you must 
update the projected device version and reload the device after installing the Unified Runtime 
update.

Images for Unified Panel
• Images can be downloaded from the Industry Online Support.
• Images are released independent of WinCC (TIA Portal). 
• Use ProSave to import an image version that does not correspond to the configured device 

version onto a panel.
• If a new image only contains improvements for the runtime of the device, this version is not 

shown in the engineering system. In this case, use the latest device version displayed in the 
engineering system.

• If the image 18.0.0.0 is installed on the device, install image download version V18.0 Upd.3 
or higher before you load a device with the configured device version 18.0.0.3. When loading 
this device, activate the setting "Keep aspect ratio" in the "Load preview" dialog so that the 
new image version is transferred to the Panel. Alternatively, use ProSave.

• If you load a device with the configured device version 18.0.0.0, it is not absolutely necessary 
to update the image on the Panel. If you load a device with the configured device version 
18.0.0.0 onto a panel with a higher device version, warnings are displayed pointing out the 
different versions. You can ignore them.

Processes for WinCC Unified Simulation
Additional processes and services are also installed during the installation of the TIA Portal or 
components of the TIA Portal. You can find an overview of these processes, the associated 
services and their respective functions in the information system under "Installation > Overview 
of Processes and Services of TIA Portal Components".
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The following processes for WinCC Unified Simulation are not listed in the information system 
for TIA Portal V18:

Process Corresponding service Function
UAAppStarterHost.exe UAAppStarterHost.exe System function to jump from the web client 

to the TIA Portal for ProDiag scenarios. 
OpcUAServerRTIL.exe OpcUAServerRTIL.exe Provides access to WinCC Unified via OPC UA 

protocol.
webums.exe - Web interface for user management with 

User Management Component (UMC) to 
manage UMC objects.

REPDataProviderHost.exe - Reporting enables the configuration of tem‐
plates and the creation of Excel and PDF-
based reports on production data.

WCCILgraphQLServer.exe GraphQL server GraphQL Web API

Upgrading a device version and logging data
When you upgrade the device version of the Unified device, the logging data is adapted to the 
new database scheme when the project is loaded. 
This process is irreversible. The logging data can no longer be read with a lower device version.

Character sets after Microsoft Windows 10 update
Since Windows 10 Update Version 1809, Windows allows the installation of character sets either 
with administrator rights for each user (command "Install for all users" in the shortcut menu) or 
for specific users. In order to use WinCC character sets without restrictions and load them onto 
an HMI device, the character sets must always be installed with administrator rights.
Note that the "Install" button in the view of a character set only initiates a user-specific 
installation.

Microsoft Edge limitation
If you want to start Runtime in Microsoft Edge and enter the address "https://localhost", the error 
message "INET_E_RESOURCE_NOT_FOUND" appears. In this case, use the address "https://
localhost/WebRH".
Use the latest browser version (for V18 Update 3: Microsoft Edge version 116 or higher).
Unexpected closing of the web client deletes the cookies that are necessary for displaying 
Runtime. A corresponding notice is displayed when the client is restarted. After a few 
seconds, Runtime reloads the page automatically, thereby restoring the cookies.

Find and replace with regular expressions
In the "Find and replace" pane, the "Use regular expressions" option is disabled.

Alarm texts
Alarm texts cannot reference tags directly via the tag ID but only via an alarm parameter.
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Alarm texts cannot reference any text lists which reference tags via their ID.
Proceed as follows to use a text list which references a tag in an alarm text:
1. Define an alarm parameter which references the desired tag.
2. In the alarm text use this alarm parameter to address the tag which controls the text list. 

Text lists
Only tags with the data type integer can be used to reference entries of a text list. 

Text box
In the text box of the height 20 px and smaller a scroll bar in light and dark style is displayed in 
the Engineering System and in Runtime. To avoid the scroll bar, select the height of the text box 
larger than 20 px.  

IO field: Display of the value
By default, the IO field is displayed without content. When you configure a value not equal to 0, 
the value is displayed in the IO field based on the selected output format.

IO field: In scripting
The properties "MeasurementUnit" and "MeasurementUnitType" of an IO field are reserved in 
scripting for future versions.

Slider and bar
In the slider and bar, a line near the value "0" is visible in the light and dark style when the initial 
value "0" is entered.

Runtime scripting
When you create an Alarm Subscription in Runtime Scripting, the tag that contains the 
Subscription must be defined globally. To do this, create a tag under "Global definition".

System diagnostics control
If you are using the S7-1200/1500 HMI connection, it is not possible to open or navigate to the 
lower-level views in the matrix view. Only the station/start view is displayed.
This occurs in the following cases:
• The PLC access level is set to "HMI access" and no password is set for the HMI connection.
• The PLC access level is set to "No access (full protection)" and an HMI access password is set 

for the HMI connection.
In the diagnostic buffer view, there is a restriction with the resolution of placeholders in the 
texts.
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SVG graphics
In an SVG graphic, the corner points of a polyline must be defined directly, for example <polyline 
points="100.100 150.25 150.75 200.0">.
In an SVG graphic, the XML element <defs>...</defs> must be located directly at the 
beginning of the SVG code. 
An SVG graphic can be imported only if it contains the <hmi:self> XML element.

Trend controls on Unified Panel
Due to different sampling frequencies, slight differences occur in the representation of a trend 
view in the simulation and on a Panel if the time range of the X axis is chosen very small. No 
differences are apparent for time ranges greater than 5 minutes.
If the axes of a trend control are displayed dynamically on a Unified Panel, the trend area is 
enlarged to make optimal use of the available space, especially on panels with small display 
diagonals. This behavior is not detectable in the simulation.

f(x) trend controls on Unified Comfort Panel
If the axes of an f(x) trend control are displayed dynamically on a Unified Panel, the trend area 
is enlarged to make optimal use of the available space, especially on panels with small display 
diagonals. This behavior is not detectable in the simulation.

Trend control: Bit-triggered trends
Bit-triggered trends are not supported in the control "Trend view".

Parameter set control
Parameter set control on Panels
The use of a fixed parameter set type in a parameter set control on Unified Panels results in 
erroneous behavior.

Extensive parameter set types
If errors while reading and writing PLC data occur in the context of large and nested 
parameter set types, copy the affected parameter set type and insert it again.

Renewed loading of the Unified Panel after updating of the CPU configuration
If the configuration of the CPU is changed and loaded into the control unit, the PLC 
communications certificate of the control unit is updated. 
In this case the Unified Panel connected with the CPU also has to be reloaded. After loading, 
the panel trusts the PLC certificate. 
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Dynamization of screens in screen windows
You can configure screens in screen windows that are dynamized via a tag or a script.
In this case, note when configuring the screen window:
• Dynamization via a script: A static value must always be configured for the "Screen" property 

of the screen window.
• Dynamization via a tag: Specify the screens to be displayed as conditions of the dynamization 

tag. Direct specification of the screen name in the dynamization tag is not possible.

Screen objects with "Release" event
You have configured a "Release" event for a screen object, e. g. for a button. If this button is 
pressed in runtime and, for example, a popup that covers the button opens or the position of the 
button changes due to zooming or scrolling, the function configured for the "Release" event is 
not executed. The behavior also occurs with a screen change.
Make sure that screen objects with a configured "Release" event are not impaired in their 
function during their operation in Runtime.

Configuration of the column width
You can configure maximum and minimum column widths in engineering in the properties of 
a control. 
These settings are not supported in Runtime by the following controls:
• Alarm control
• Parameter set control
• Table view
• Value table

Upgrading the lowest device version of faceplate types
Upgrading the device version of faceplate types depends on the number of faceplate types to be 
converted and can take a very long time under certain circumstances. Do not interrupt the 
process.

Basics of tags: Composition of the number of tags
The number of tags used is displayed differently at different positions in WinCC.

Default
tag table

• In the HMI device: All configured external, internal tags and the system tags.
• In the PLC: All configured PLC tags and the system constants.

User-defined
tag tables

• In the HMI device: All configured external and internal tags in the tag table.
• In the PLC: All PLC tags configured in the tag table.
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Compile When compiling an HMI device, the following information about tags is provided in 
the Inspector window:
• Number of tags: Addition of all configured, external and internal tags and their 

subelements from user data types or arrays.
Example: Two external tags of a user data type with 5 elements and one internal 
tag of the type "array" with 10 elements: 2 + 2*5 + 1 + 1*10 = 23

• Tags used: The configured, external and internal tags or their elements that have 
a usage in the HMI device.

PowerTags The number of PowerTags of an HMI device in "Properties > General > Information" 
results from the elements of the lowest level of all configured external tags in the HMI 
device.
Example: Two external tags of a user data type with 5 elements: 2*5 = 10

Incorrect counting of tags
When using faceplates in Unified Panels (Basic and Comfort), tag arrays and tags based on User 
Data Types (UDT) are incorrectly counted as 1 tag.

HMI tags with user data type
When HMI tags whose data type is a user data type are exported, configured limits and start 
values are not exported.

Address multiplexing
Only numeric data types are allowed to be used for index tags for address multiplexing.

Data types of trigger tags for alarms
Trigger tags of alarms must have the following data types: 
• Discrete alarms: "Byte", "Word", "DWord", "LWord" or array with "Byte", "Word", "DWord", 

"LWord"
• Analog alarms: "Int", "Real", "LReal", "SInt", "USInt", "UInt", "UDInt" and "ULInt"

Standard languages for system alarms
Texts of system alarms are available in the following languages by default:
• English (USA)

German (Germany)
Chinese (People's Republic of China)
French (France)
Italian (Italy)
Spanish (Spain)

If you want to output system alarms in other languages, you can manually create texts in that 
language.
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Alarm without inactive state without acknowledgment
An alarm with the state machine "Alarm without inactive state without acknowledgment" is only 
displayed in the "Show logged alarms" and "Show and update logged alarms" views.
The following predefined alarm classes use this state machine: "Information", "System 
information", "OperatorInputInformation".

Use of different types of databases for logging
The database types SQLite and Microsoft SQL are available for logging tags and alarms. 
We recommend that you use Microsoft SQL for data logs under the following conditions: 
• Number of tag value changes to be logged greater than 500 per second
• More than 1.3 billion log entries must be available (excluding deleted log segments in the 

backup)
The use of Microsoft SQL for alarm logs is recommended under the following conditions: 
• Number of alarm states to be logged greater than 100 per second
• More than 26 million log entries must be available (excluding deleted log segments in the 

backup)

Scheduled tasks
No UI functions may be used in scripts or in referenced global modules in the Scheduler. When 
compiling, an error is still generated even if the scheduled task is already deleted.

"HMI Monitor Client" role
A user who is assigned the "HMI Monitor Client" role or the "Enable HMI Monitor Client" function 
right contained in the role cannot make any changes or write operations in the processes, 
regardless of other assigned roles and function rights.

Scripting
To correctly export logging data in CSV format in a script using the snippet "HMI Runtime > Tag 
logging > Export tag log as CSV", you must modify the line with the definition of the file name 
in the code of the snippet as follows:
let fileName = "C:\\Users\\Public\\TagLogFile.csv";
When closing popup windows, scripts executed in them are canceled. In some cases, 
asynchronous scripts may not be fully executed. Make sure that asynchronous functions are 
fully completed before the popup is closed.
Search and replace is possible for global scripts, but not for local scripts.

Data access on network drives via scripting
The remote access to files which are located on a network drive is for safety reasons not 
supported via runtime scripting.
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Trend control: Compression of values for logging tags
The "AggregationMode" property specifies the type of compression of values for logging tags:
• TimeAverageStepped (1): Average across time in steps
• MinMax (2): Lowest and highest value from the defined period
Deactivation of the compression via the property is not possible.

Process diagnostics
If you add an "Info text" or one of the additional texts to the alarm texts, this source text must not 
be empty. 

Performance features for SIMATIC Unified PC communication
SIMATIC NET is required to use more than 10 connections.

S7 routing
Unified devices cannot establish communication with S7-300 or S7-400 via S7 routing.

Reading and setting the operating mode of an S7-1200/1500 - Length of tag names
The procedure for handling long tag names has been adjusted.
If there are 2 tags with the same name and a length of 128 or more characters each, the 
name of the second tag is shortened so that he length of the name is 128 characters after 
the suffix (1) is appended.
Example: 
@ConnectionName_1234567890ConnectionName_1234567890ConnectionName_12
34567890ConnectionName_123_PLC_OpStateC(1)

Connections to Smart Clients
A maximum of 3 parallel connections to Smart Clients are supported. 
Additional connections are not prevented, but lead to a reduction in performance. 

Connections to 3rd-party PLCs 
As of V18 Update 2, a maximum of 16 connections are supported for communication drivers of 
3-party PLCs. This number can be a combination or 16 individual communication drivers.
The specification is only valid for Ethernet-based communication drivers and is additionally 
limited by the maximum possible number of connections at the respective PLC type.

Communication with LOGO! PLC
For the communication with a LOGO! PLC, select “Standard Modbus TCP/IP” in the connection as 
the communications driver.
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Modbus RTU support
The communication driver "Modbus RTU" is only supported by Unified Comfort Panels. Using the 
communication driver with a Unified PC is not possible.

Unified Collaboration
Devices that are connected via Unified Collaboration must be time-synchronized.

Audit Viewer license
A basic license is required for the use of Audit Viewer.

Audit Trail - Format
Audit supports the following formats for logging:
File-based logging
File-based logging allows you to record up to 5000 logging tags in an SQL Lite database.
Database-based logging
Database-based logging allows you to record all logging tags up to the high limit in an MS 
SQL database.

System function "StopRuntime" in Audit Trail
The "StopRuntime" function is not supported by Audit and is not logged in the Audit Trail.

System function "CreateParameterSet"
The value of the parameter set "ParametersetName" of the system function 
"CreateParameterSet" does not contain any language ID and is written automatically under the 
English language ID.
Assign the name of the parameter set manually for other languages.

View of Things
In a VoT application, you cannot use asynchronous operations in scripts. The scripts run in VoT 
in a browser and are converted to an asynchronous version.
A VoT application cannot by compiled if the "Input finished" event is dynamized at an IO field. 

"ErrorLog" worksheet in report templates
Report templates automatically include the "ErrorLog" worksheet. 
Do not delete, rename or edit the worksheet. If required, you can hide the worksheet.
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Recreating cross-references in case of faulty cross-reference list
If there are errors in the cross-reference list or if it is empty, you can manually recreate the cross-
reference information under "Extras > Options > General > Cross-references".

Connecting Unified Comfort Panel with MS SQL or SQLite database
You can access MS SQL databases and SQLite databases via JavaScript functions from the 
Unified Comfort Panel.
• Microsoft SQL with the driver "ODBC Driver 17 for SQL Server"
• SQLite with the driver "SQLite3"
To create a connection to the database with the "CreateConnection" method, a 
"connectionString" parameter of the type "String" is transferred. The "connectionString" 
parameter has the form:

MS SQL let connectionstring = "DRIVER={ODBC Driver 17 for SQL 
Server}; DATABASE=UCP; UID=userid; PWD=password; 
trusted_connection=no; SERVER=ipaddress,port_number; 
TrustServerCertificate=yes";
Example:
let connectionstring = "DRIVER={ODBC Driver 17 for SQL 
Server}; DATABASE=UCP; UID=TestUser; PWD=test; 
trusted_connection=no; SERVER=192.168.0.115,1433; 
TrustServerCertificate=yes";

SQLite let connectionstring = 
"Driver={SQLite3};Database=PathToDatabase; 
trusted_connection=yes;";
Example:
let connectionstring = "Driver={SQLite3};Database=/media/
simatic/X51/MyUCP.db; trusted_connection=yes;";

Time synchronization in the Unified Panel when upgrading
If you upgrade a V18, V18 Update 1 or V18 Update 2 project for which the time synchronization 
is activated via NTP server, an error message can appear during compiling due to an invalid 
update interval.
Click "Go to" and select a valid update interval.

Time zones in Controls and I/O fields
Please note that I/O fields have no setting possibility for the time zone. Values for the times are 
therefore always treated as UTC. 
For most Controls you can configure the time zone according to the index values of the 
Microsoft time zones. By default, the value "-1" is set there, meaning the local time zone of 
the device. 
Configure the time zone in the Control to avoid possible deviations from I/O fields.
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Upgrading after restoring log segments
If you restore log segments for logging alarms or Audits on a Unified PC with Runtime V17, V18 
or V19 installed and then upgrade the PC to V19 or V19 Update 2, Runtime can no longer access 
the entries from the restored segments after the upgrade.
To restore access, follow these steps:
1. Make sure the device is running the Audit service and the AlarmLogging service.
2. Open SIMATIC Runtime Manager on the device.
3. In SIMATIC Runtime Manager, delete all restored log segments.

Proceed as described in the operating instructions of SIMATIC Runtime Manager.
4. To restore access to the segments restored before the upgrade, restore the log segments.

Proceed as described in the operating instructions of SIMATIC Runtime Manager.

"Read" and "Write" methods for arrays
Only call the "Read" and "Write" methods at array elements.
Calling the methods at the higher-level array tag itself is not supported.

4.3 Important changes in behavior

Alarm control
As of V18 Update 1, alarm control supports multi-line alarm texts. Texts with line breaks are 
automatically converted into multi-line texts.
This also applies if you upgrade a project to V18 Update 1 that contains alarm texts with 
manually configured line breaks. As a result, texts may no longer nr displayed in full in the 
alarm control in runtime. In this case, adjust the row height in alarm control manually. 

OPC UA with OpenSSL 3.0
As of V18 Update 3, OpenSSL 3.0 is used for WinCC Unified OPC UA. 
If the OPC UA certificate of an HMI device was created before V18 Update 3, it becomes 
incompatible through the device upgrade. Recreate it. Follow these steps.
HMI device uses CA-based certificate
1. Upgrade the certificate authority device and the HMI device.
2. Recreate the OPC UA certificate of the HMI device on the certificate authority device with 

WinCC Unified Certificate Manager.
3. Install the certificate on the HMI device.

If the communication partner already trusts the root certificate of the certificate authority, it 
automatically also trusts the newly created OPC UA certificate of the HMI device. 
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HMI device uses a self-signed certificate
1. Delete the certificate from the certificate store before upgrading the HMI device. Delete both 

the DER file and the PFX file. 
Proceed as follows:
– The HMI device is a Unified PC: 

Delete the files from the following 
folder: C:\ProgrammData\SCADAProjects\certstore

– The HMI device is a Unified Panel: 
Select "Control Panel > Security > Certificates" and as the "Certificate store" the entry "My 
Certificates". 
Select the certificate and delete it.

2. Upgrade the HMI device.
3. If the HMI device is a Unified PC:

– Open the Windows command line in administrator mode.
– Navigate to the following folder: 

C:\Program Files\Siemens\Automation\WinCCUnified\bin
– Run the following commands:

OpcUaServerRTIL.exe -CreateCertificate
OpcUaExporter.exe -CreateCertificate

4. If the HMI device is a Unified Panel: Start Runtime.
The certificate is automatically generated and installed.

5. Trust the certificate on the communication partners.

OPC UA Local Discovery Server
If the OPC UA Local Discovery Server Version 1.04.405.481 has been installed, the LDS will be 
removed when V18 Update 5 is installed for security reasons.

4.4 Addressing of screen objects in functions
In some functions, e.g. FindItem, SetPropertyValue and GetPropertyValue, the object path is 
used to address a screen object.

Addressing with absolute object paths
The object path of screen objects consists of the names of screen windows (ScreenWindows) 
and screen objects (ScreenItems). The names are connected according to their hierarchical 
arrangement using a slash ("/"). The object path ends with the screen object to be addressed. 
Screens (Screens) and their names are not used in the object path.
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The absolute object path addresses a screen object starting from the screen window at the 
highest level (TopLevelScreenWindow). Note the following:
• A single slash "/" at the start of the object path addresses a top-level screen window whose 

name must follow, e.g. "/Main screen window".
• A top-level screen window generally has no name. By using a double slash "//", all screen 

objects of the screen in the top-level screen window can be addressed, e.g. "//Button_1".
• If a main screen window has been defined in the screen management, it becomes the top-

level screen window and has a name. All references must include the name of the main 
screen window, e.g. "/Main screen window_1/Button_1". References with double slashes "//" 
no longer function and must be adapted.

• Alternatively, the tilde character "~" addresses the top-level screen window in the screen 
window's own screen hierarchy, e.g. "~/Button_1".

• Within a popup window (PopupScreenWindow), the popup window itself is the top-level 
screen window and is addressed with double slashes "//" or its own name, e.g. "/Popup 
window_1". Scripts within popup windows can address an unnamed top-level screen 
window outside the popup window only using UI.Windows(0).Name.

Examples of the use of absolute object paths
• Addressing using the screen window's own screen hierarchy:

UI.SysFct.SetPropertyValue('~/Screen window_1/Screen window_2/
Circle_1', "Visible", 0);

• Addressing using an unnamed top-level screen window:
UI.SysFct.SetPropertyValue('//Screen window_1/Screen window_2/
Circle_1', "Visible", 0);
Please note that this notification cannot be used if a named top-level main screen window 
exists.

• Addressing using a main screen window of the screen management:
UI.SysFct.SetPropertyValue('/Main screen window_1/Screen window_1/
Screen window_2/Circle_1', "Visible", 0);

• Addressing using an unnamed top-level screen window from a popup window:
UI.SysFct.SetPropertyValue('/' + UI.Windows(0).Name + '/Screen 
window_1/Screen window_2/Circle_1', "Visible", 0);

4.5 Improvements in Engineering and Runtime

4.5.1 Improvements in Update 5
This update contains the following improvements and changes:
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Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Unified Comfort Panel: Start in Runtime
The start screen now loads faster when loaded initially.

4.5.2 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Reports
• Report templates can be configured in such a way that the values of the data table of a 

segment are visualized in an Excel chart. 
The following chart types, including their subtypes, are now supported:
– Column
– Line
– Pie
– Bar
– Area
– XY (Scatter)
– Radar
– Treemap
– Sunburst
– Histogram
– Box
– Waterfall
– Funnel
The interaction of data table and chart has been improved. A configured chart now always 
evaluates the entire range of the data table in the generated report.

• Report generation performance has been improved. Reports with time series segments 
containing large data volumes are now generated more quickly.
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• The formula of a user-defined column can now also contain references to multiple cells of the 
same column.

• The formatting for data source elements of the tag type has been corrected in single value 
segments. When you format a tag's cell as text in Excel, the value read from Runtime is now 
formatted as a string even if the variable has a numeric data type in Runtime.

Simulation
For simulations on panels, the flashing of objects in the process picture has been improved when 
the flash rate of the first object to flash is set to "None".

Documentation object model
• In the description of the object model the property "Duration" was added for the object 

"LoggedAlarmStateResult".
The "Duration" property returns the duration of a logged alarm. The duration is defined as the 
time interval between activation of the alarm and the last change of the alarm state. The 
value of the property is specified in units of 100 nanoseconds.

• In the description of the object model the property "Properties" was inserted in the property 
"Tag" of the object "FaceplateType".
The property "Properties" only has the property "Tag" (type "String"), which contains the 
name of the connected project tag. If you write the "Tag" property, the new value must 
contain the name of a tag with the same data type.

4.5.3 Improvements in Update 3

4.5.3.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Process diagnostics
The process diagnostics can be disabled or enabled in the Runtime settings via "Process 
diagnostics > General > Enable process diagnostics". The process diagnostics is disabled as 
default.  If process diagnostics are deactivated, an error message appears when compiling if a 
ProDiag control is configured.

GRAPH overview
The functionality of the GRAPH overview has been extended.
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ProDiag overview
The functionality of the ProDiag overview has been extended.

PLC code view
The functionality of the PLC code view has been extended.
If you select a symbol in a LAD network or FBD network, you see information on this symbol 
in the symbol line.

Criteria analysis
The display of the criteria analysis for ProDiag alarm or GRAPH alarm has been improved.
In the GRAPH overview, the first faulty operand of the criteria analysis is displayed.
When changing from the alarm control or the GRAPH overview to the PLC code view, the first 
faulty operand is highlighted if a ProDiag alarm or GRAPH alarm is selected. 

OpenFaceplateInPopup
The following optional parameters have been added to the "OpenFaceplateInPopup" method:

Parameter Description
popupWindowName Name of the popup window. 

Note that the name must be unique in the project.
If the parameter is omitted, a unique name is generated automatically.

adaptWindow If true, the size of the popup window is automatically matched to the size 
of the faceplate and cannot be defined by the "width" and "height" param‐
eters.
The default value is true.

left Left coordinate of the position of the popup window.
The default value is 10.

top Upper coordinate of the position of the popup window.
The default value is 10.

width Width of the popup window.
Is used if the "adaptWindow" parameter is false.
The default value is 100.

height Height of the popup window.
Is used if the "adaptWindow" parameter is false.
The default value is 100.

By using the new parameters, faceplates are shown in the correct size in popup windows.
Since the parameters are optional, this has no effect on existing scripts.
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4.5.3.2 Discrete alarms

Sending an alarm acknowledgment to the PLC
Requirement
• The "HMI alarms" editor is open.
• The desired alarm is created and assigned to an alarm class with mandatory 

acknowledgement.

Procedure
To configure the acknowledgment of an alarm to be sent to the PLC, follow these steps:
1. In the "HMI alarms" editor, click the "Discrete alarms" tab and select the desired discrete alarm.
2. In the Inspector window, select "Properties > Properties > Acknowledgment".
3. Under "Status tag", select the tag and the bit set by the alarm acknowledgment function.

The selection of the tags depends on your configuration in the "HMI tags" editor and the fact 
whether the alarm is acknowledged is stored in these tags.
Supported data types for the status tag: Word, DWord, LWord, Byte. 
Note
The HMI device and PLC only have read access to the status tag memory area.

Note
The normal status of the bit is 1.
When the alarm is in the "active" state, the bit changes from 1 to 0.
When you acknowledge the alarm, the bit changes from 0 to 1.

To configure that the alarm is acknowledged by the PLC, follow these steps:
1. In the "HMI alarms" editor, click the "Discrete alarms" tab and select the desired discrete alarm.
2. In the Inspector window, select "Properties > Properties > Acknowledgment".
3. Under "Control tag", select the tag and the bit set by the alarm acknowledgment function.
4. The tag can be any tag, there are no restrictions.

Supported data types for the control tag: Word, DWord, LWord, Byte.
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Result
If the operator acknowledges the alarm in Runtime, the operating step is forwarded to the PLC.

4.5.3.3 Initial value acquisition and criteria analysis

Overview of initial value acquisition and criteria analysis

Introduction
In the TIA Portal you have the option of testing the execution of your user program on the HMI 
device. The data and values on the HMI device are continuously synchronized with the PLC and 
updated. You therefore see the current program status with the actual values of the signal states 
on the HMI device.
If an error occurs in your plant, you have the option of jumping to the program code from 
the corresponding error message and displaying the error location in the network in the “PLC 
code view". In the "Criteria analysis view" object, you see the faulty operands for a selected 
GRAPH alarm or ProDiag alarm at a glance. 
The initial value acquisition and criteria analysis functions enable you to record the values at 
the time of the error and to quickly identify the faulty operands in the program.
The actual value acquisition and criteria analysis functions are available for GRAPH function 
blocks, ProDiag function blocks and safety programs (F-blocks).
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Requirement
• The initial value acquisition is available in WinCC Unified Runtime for the following blocks:

– For the GRAPH function blocks as of version 6.0.
– For the ProDiag function blocks as of version 2.0.

• Maximum of 32 statuses can be recorded. The initial values for a network that contains more 
than 32 elements are not recorded.

Initial value acquisition
With the help of initial value acquisition you can acquire the values at the time of the error in the 
PLC, display them in the PLC code view and compare them with the actual values. With initial 
value acquisition you continuously record the signal states of Boolean operands and results of 
comparators in transitions and interlocks. 
The signal states are recorded in a defined order from top left to bottom right: 

1 3

2

You activate initial value acquisition individually for each GRAPH block in the user program. 
A maximum of 32 signal states of Boolean operands can be recorded per interlock or per 
transition of a GRAPH step. Each individual signal state occupies one bit. The values are saved 
in a DWORD.
In the following example you can see the principle and order in which the initial values are 
recorded in the interlock:
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Criteria analysis
Initial value acquisition in the PLC enables the analysis of criteria and operands with error in the 
program. You see the evaluation of the criteria analysis on your HMI in the PLC code view. In 
addition, in the "Criteria analysis view" object, you can use the criteria analysis to have the faulty 
operands displayed for a selected GRAPH alarm or ProDiag alarm. 

Note
If the upstream network has been changed, the alarm is not be triggered again. This leads to 
inconsistencies between the network and faulty operands. As a result, the criteria analysis view 
cannot correctly display the faulty operands. If the alarm is triggered again, the faulty operands 
are displayed correctly again in the criteria analysis view. 

For the blocks for which you have activated initial value acquisition, after the jump the initial 
value view is displayed by default in the PLC code view. In addition, the operands with error 
and criteria are highlighted visually in the initial value view.
All information about the selected operand can be seen in one line of the PLC code view.
In the event of an error in a comparator, both operands are marked as having errors. Only 
the recorded values are shown in the initial value view. To see the actual values of the tags, 
change to the actual value view.
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Supported instructions

Introduction
You see the initial values and the results of the criteria analysis in the "PLC code view" object.
For global supervisions, the initial values of all Boolean operands in the network are 
recorded. If the network contains multiple individual power rails that are not connected 
to each other, only the initial values of the respective power rail are recorded.
For local supervisions, only the initial values that are specified as conditions for the 
supervised parameter for the block call are recorded.

Supported instructions
The following instructions are supported in LAD and FBD for initial value acquisition:

Instructions Display on the HMI device
Bit logic operations
Normally open contact Initial values and criteria analysis
Normally closed contact
Invert RLO The instruction is supported but it is not relevant for initial values 

or the criteria analysis.Assignment
Negate assignment
Reset output Initial values
Set output
Set/reset flip-flop Initial values and criteria analysis up to and including the instruc‐

tion boxReset/set flip-flop
Comparator operations
Equal Initial values and criteria analysis
Not equal
Greater or equal
Less or equal
Greater than
Less than
Timers
TP Initial values and criteria analysis up to and including the instruc‐

tion box
TON Initial values and criteria analysis
TOF Initial values and criteria analysis up to and including the instruc‐

tion box
 

TONR

Counters
CTU Initial values and criteria analysis up to and including the instruc‐

tion boxCTD
CTUD
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For bit logic operations, the status of the operand is recorded. For comparators, the result of 
the comparison is recorded.
For flip-flops, both inputs (R and S) are recorded if they are interconnected.
For timers and counters, the status of the operand at the output, and the inputs if they are 
interconnected, are recorded. (For example, for CTUD: CU, CD, R, LD)
The FBD instructions AND and OR are also supported for initial value acquisition and criteria 
analysis. The FBD instruction EXCLUSIVE OR is not supported by the initial value acquisition 
and criteria analysis.

Criteria analysis view (RT Professional, RT Advanced, Panels, Comfort Panels)

Use
The "Criteria analysis view" object shows you the faulty operands in the user program that have 
triggered a selected ProDiag alarm or GRAPH alarm. As a result, you have the option of seeing the 
list of faulty operands in addition to the alarm in the same screen. 
To see the evaluation of the criteria analysis in the "Criteria analysis view" object in Runtime, 
select the initial value acquisition in the settings of the function blocks in the user program. 
The initial value acquisition is available for GRAPH function blocks as of version 6.0 and 
ProDiag function blocks as of version 2.0.
To enable the link to the corresponding error message, configure a reference to a previously 
configured alarm control. If you select a GRAPH alarm or a ProDiag alarm in the alarm control 
in Runtime, then the name, address, comment and value of the operand that caused this 
error is displayed in the criteria analysis view.
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You see the incoming alarms and the operands with errors at a glance in runtime if you 
configure the criteria analysis control and its linked alarm control in the same screen.

Note
Criteria analysis is only available for the user programs for which initial value acquisition has 
been activated. 
Activate initial value acquisition in the properties of the following blocks:
• ProDiag function blocks with version greater than or equal to V2.0 
• GRAPH function blocks with version greater than or equal to 6.0

Layout
You change the settings for the position, style, colors, and fonts of the object in the Inspector 
window.

Columns
The following columns are displayed in the criteria analysis view in Runtime.

Column Description
Symbol name Symbolic name of the operand in the user program.
Address Absolute address of the operand. The specification of the absolute 

address is only possible for operands that are listed in the PLC tag table.
Value The value of the operand at the time of the error.
Comment Additional comments from the user program in the language that is 

loaded into the controller.

Configuring the criteria analysis view (RT Advanced, Panels, Comfort Panels)

"Criteria analysis view" object
The "Criteria analysis view" object shows you the faulty operands in the user program that have 
triggered a selected ProDiag alarm or GRAPH alarm. It is used to list the initial values in a separate 
view in order to obtain an overview of the fault status of the plant.  
If you select the incoming ProDiag alarm or GRAPH alarm in the alarm control in Runtime, 
you see the operands that were determined in the criteria analysis view. 
You configure the criteria analysis view and its linked alarm control in the same screen.

Requirement
• The HMI device is connected to the controller.
• A ProDiag program version 2.0 or a GRAPH program Version 6.0 or higher is installed on the 

controller.
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• Process diagnostics is enabled in the "Runtime settings > Process diagnostics > General" of 
the Unified Runtime device.

• Initial value acquisition is enabled for the function blocks.
• An alarm control has been configured.

Procedure
1. Move the criteria analysis view from the toolbox window using drag-and-drop. 
2. Click on "Properties > Properties" in the Inspector window.
3. Open the selection button under the "Data source" property. 
4. Select the configured alarm control.
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Result
The criteria analysis view is configured in the screen and connected to the alarm control. For a 
selected alarm you can see detailed information in Runtime about that operands that triggered 
this alarm.

Outputting alarms with criteria

Introduction
When initial value acquisition is activated, the values of the operands with errors are acquired 
at the time of the error and missing criteria are analyzed and determined on the HMI device. 
You have the option to add additional information about faulty operands to the GRAPH and 
ProDiag alarms and output them on your HMI device. If an error occurs in the program flow 
in runtime, the error message also shows the operands with errors in the affected network. 
You see detailed information on all operands with error of the error message in the "Criteria 
analysis view" object.

In WinCC Unified Runtime, you have the option to add additional information to the alarms. 
For this, select the appropriate text that you want to extend under "Runtime settings > 
Process diagnostics > Criteria analysis > Extend text", i.e. alarm text, info text or additional 
text 1 - 9. You can extend the texts with the first faulty operand or with all faulty operands.
The following information can be added to the operands:
• Symbol: The symbolic name of the first or all faulty operands.
• Absolute address: The address of the first or all faulty operands.
• Value: The value of the first or all faulty operands at the time of the fault.
• Comment: Multilingual comments that were configured in the user program.
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The additional information is separated in the alarm by semicolons and spaces. 

Note
The order of the additional information that is added to the alarm is predefined and cannot be 
changed.

Note
To completely display the alarms from the controller on the HMI device, the "Automatic update" 
option must be selected under "Runtime settings > Alarms > Controller alarms" for the relevant 
connection. You can find additional information on complete alarms under "Sending a complete 
alarm from the controller to the HMI device". 

Criteria analysis in the alarm system
You visualize the alarms for the criteria analysis in the following steps:
• You enable the initial value acquisition in the properties of the ProDiag function block or 

GRAPH function block of the user program
• You enable the options to extend the alarm texts or info texts in the runtime settings of the 

HMI device

Extend alarms
1. Open the "Runtime settings" editor of the HMI device.
2. Click "Process diagnostics > Criteria analysis".
3. Under "Criteria analysis > Extend text", select which texts you want to extend.
4. Select the additional information to be added to the alarm text in the alarm, such as symbol 

name, address and value of the first faulty operand and comment.
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Result
If an error occurs, you see not only the alarm text in the alarm control but also the operands that 
triggered the error message. 

Criteria analysis in the "GRAPH overview" object (RT Advanced, Panels, Comfort Panels)

Extension of the "GRAPH overview" object with the criteria analysis
To display the criteria analysis in the "GRAPH overview" object, the criteria analysis must be 
enabled in the Inspector window under "Properties > Properties > Information bar > Elements".

Result
In runtime, the information bar of the "GRAPH overview" object displays the symbolic name of 
the 1st faulty operand.
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4.5.4 Improvements in Update 2

4.5.4.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Compilation after library update
Projects can also be compiled after a library has been upgraded.

Zooming without pressing the control button
You can configure zooming in runtime in the runtime settings of the device. You have the 
following options:
• Zooming by turning the mouse wheel with pressing the control button.
• Zooming by turning the mouse wheel without pressing the control button.
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To zoom in runtime without pressing the control button, follow these steps:
1.  Under "Runtime settings > General > Screen", activate the option "Zoom without pressing the 

control button".
This option is disabled by default.

Symbolic I/O field
The display of symbolic I/O fields with "Input/output" mode has been improved in engineering 
and Runtime.

Scripting
Arrays with tags of the WString data type can be used within user-defined functions.
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Reading and setting the operating state of an S7-1200/1500
The operating state of an S7-1200/1500 PLC can be read and set via system variables.
• @ConnectionName_PLC_OpState reads the state of the PLC.
• @ConnectionName_PLC_OpStateCtrl sets the state of the PLC.
The tags are available if a connection to a PLC of the type S7-1200/1500 is configured.
The tags are available as of version 18.0.0.2. If the version of a device is changed to an older 
version, these tags are no longer available.
If the connection is removed or the connection type is changed, the tags are removed.
This functionality replaces the system functions "SetPlcMode" and "GetPlcMode".

4.5.4.2 System functions

System functions for the jog mode of tags
The new JavaScript object "Tags.Inching" contains the functions:
• "Tags.Inching.SysFct.ReadAndDecreaseTag()"
• "Tags.Inching.SysFct.ReadAndIncreaseTag()"
• "Tags.Inching.SysFct.ReadAndInvertBitInTag()"
• "Tags.Inching.SysFct.ReadAndSetBitInTag()"
• "Tags.Inching.SysFct.ReadAndResetBitInTag()"
• "Tags.Inching.SysFct.ReadAndSetTagValue()"
The system functions "ReadAndDecreaseTag", "ReadAndIncreaseTag", 
"ReadAndInvertBitInTag", "ReadAndSetBitInTag", "ReadAndResetBitInTag" and 
"ReadAndSetTagValue" are available in the function list.
The functions differ from "DecreaseTag", "IncreaseTag", "InvertBitInTag", "SetBitInTag", 
"ResetBitInTag", and "SetTagValue" in the following ways:
• The HMI device updates the value of the HMI tag with the value from the PLC before the write 

operation occurs.
• After the write operation, the value of the HMI tag is updated immediately, e.g. in an IO field.
The new functions are slower due to the updating of the tag at the beginning and end of 
jog mode. It is recommended that you use the new features only when they need to perform 
time-critical tasks.

"ActivateCleanScreen" system function
The "UI.SysFct.ActivateCleanScreen()" function opens a screen as a pop-up in full-
screen mode and disables the touch screen of the Unified Panels. While the clean screen is open, 
no screen object of the underlying screen can be used. The pop-up is closed after the configured 
time interval has elapsed.
The "ActivateCleanScreen" system function is available in the function list.
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System function "SetPLCDateTime"
The "HMIRuntime.Connections.SysFct.SetPLCDateTime()" function sets the date 
and time of the HMI device in the connected PLC. Note that this function can only be configured 
for SIMATIC S7-1200/1500.
The "SetPLCDateTime" system function is available in the function list. 

"OpenPLCCodeViewByAlarm" system function
When an alarm is selected in the alarm view, the 
"UI.ProDiag.SysFct.OpenPlcCodeViewFromAlarm()" function opens the 
corresponding block in the PLC code view.
The "OpenPLCCodeViewByAlarm" system function is available in the function list.

"OpenScreenInPopupAsync" system function
The "UI.SysFct.OpenScreenInPopupAsync()" function opens a screen asynchronously 
in a popup window. This also makes it possible to initialize the PLC code viewer in a popup 
window and use it from a GRAPH overview.
The "OpenScreenInPopupAsync" system function is available in the function list. 

System functions "CreateSystemMessage", "CreateOperatorInputInformation" and 
"CreateSystemInformation"

The integration of parameter values in system alarm texts has been improved for the system 
functions "CreateSystemMessage", "CreateOperatorInputInformation" and 
"CreateSystemInformation".

4.5.5 Improvements in Update 1

4.5.5.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Segment-based backup for SQLite
Segment-based backup is supported as of V18 Update 1 for all archive types of the HMI devices 
Unified PC and Unified Comfort Panel. 
The following requirement must be met:
• The "SQLite" database type must be enabled for the HMI device.
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To use segment-based backup for SQLite, follow these steps: 
1. Under "Archives", create one of the following archives: 

– Data log
– Alarm log
– Audit Trail 

2. Under "Backup mode", select the "Path" option and specify a path for the backup.
For Unified Comfort Panel, the fully qualified mountpoint path is required. 
Example: To use the "MyBackup" directory, specify the path "/media/simatic/data-storage-1/
MyBackup". The mountpoint name is "data-stoarge-1".
A network folder can be configured using the mountpoint name specified in the Control 
Panel.

Parameter sets and parameter set control
The following improvements have been made for parameter sets and the parameter set control 
with V18 Update 1:
• Parameter sets can be created in the parameter set control, even if the parameter set type 

elements consist of multiple levels. 
• If you transfer new parameter sets into the parameter set control with the "Read from PLC" 

button, the parameter sets are then displayed as selected in the selection menu.

4.5.5.2 System functions and scripts
This update contains improvements for:
• System functions

System function for opening the login dialog
The new "HMIRuntime.UI.UserManagement.SysFct.ShowLoginDialog()" system 
function is installed with the update. The "ShowLogOnDialog" function is available in the 
function list. With the system function, you open a login dialog for entering user name and 
password without leaving the currently displayed screen.
Only local user management supports the "ShowLogOn Dialog" system function.

System function for external control of the system diagnostics control
The new "UI.SysDiag.ExecuteToolbarButton()" system function is installed with the 
update. The "ExecuteToolbarButton" function (system diagnostics control) is available in the 
function list. The system function is used to control the buttons of the toolbar in the system 
diagnostics control.
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System function for external control of the parameter set control.
The new "UI.ParameterControl.SysFct.ExecuteToolbarButton()" system function 
is installed with the update. The "ExecuteToolbarButton" function (parameter set control) is 
available in the function list. The system function is used to control the buttons of the toolbar in 
the parameter set control.

System function for external control of the alarm control
The new "UI.Alarm.SysFct.ExecuteToolbarButton()" system function is installed 
with the update. The "ExecuteToolbarButton" function (alarm control) is available in the function 
list. The system function is used to control the "Single acknowledgment" and "Group 
acknowledgment" buttons of the toolbar in the alarm control.

Extension of the "InsertElectronicRecord" system function
The "HMIRuntime.Audit.SysFct.InsertElectronicRecord()" system function is 
extended with the update. The "InsertElectronicRecord" function is available in the function list.
The "Confirmation type" parameter, which specifies how the action must be confirmed, has 
been extended:
• 0 = (None): No confirmation required, an entry is created in the Audit Trail.
• 1 = (Acknowledgement): Acknowledgment, the user must acknowledge the action; an entry 

is created in the Audit Trail.
• 2 = (Acknowledgement + Comment): Acknowledgment, the user must acknowledge the 

action and enter a comment; an entry is created in the Audit Trail.
• 4 = (Digital Signature): Electronic signature; a dialog window opens in which the user must 

enter the electronic signature; an entry is created in the Audit Trail.
• 6 = (Digital Signature + Comment): Electronic signature; a dialog window opens in which the 

user must enter the electronic signature and a comment; an entry is created in the Audit Trail.
The "Required function rights (optional)" parameter has been added. If the confirmation type 
requires an electronic signature, the function right required for the electronic signature must 
be specified: 
• 0 = No function right required. 
• 1 = The "First electronic signature" function right is required.
• 2 = The "Second electronic signature" function right is required.
• 3 = The "First electronic signature" and "Second electronic signature" function rights are 

required.

ActiveScreen property
The "ActiveScreen" property now always returns the screen that has the input focus. If the I/O 
field in a screen window or a faceplate has the input focus, ActiveScreen thus returns the screen 
that is displayed in the screen window or faceplate respectively. If you used ActiveScreen to edit 
the coordinates in the "OpenFaceplateInPopup" script function, for example, this may result in 
the popup being opened at a different location than it was in previous versions.
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4.5.5.3 User management
This update contains improvements for:
• Incorrect login attempts

Incorrect login attempts
In the runtime settings, you can specify whether and after how many failed login attempts a user 
is blocked.

4.5.5.4 Diagnostics
This update contains improvements for:
• Process diagnostics
• System diagnostics

Process diagnostics
The stability of process diagnostics objects has been improved.

ProDiag overview
The "ProDiag overview" object provides an overview of the current status of the configured 
monitoring in Runtime. When an error occurs, the type of error and the error category are 
determined in the ProDiag overview. You can navigate directly to the alarm control to find the 
error and you can jump from the corresponding alarm to the PLC code viewer control. You 
can display the affected program code in the PLC code viewer control.  

Improvements in WinCC Unified
4.5 Improvements in Engineering and Runtime

Readme
Readme, 10/2024, A5E52423187-AE 69



In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adjust the following properties in particular: 
• Displayed buttons
• Names and colors for categories
• Names and colors for supervision types
You can display a maximum of 8 categories and 6 supervision types in the "ProDiag overview" 
object. The following pre-defined categories and supervision types are available:

Categories
Name Categories
E (Error) Error
W (Warning) Warning
I (Info) Information
C4 ... C8 Additional categories

Supervision types
Name Supervision types
O (Operand) Operand error
I (Interlock) Interlock error
R (Reaction) Reaction error
A (Action) Action error
P (Position) Position error
M (Message error) Alarm

"Jump to Alarm Control" button
The "Jump to Alarm Control" button in the ProDiag overview is activated by default.

Button Name Function
Jump to Alarm Control Opens the configured alarm control with the error message 

after the button has been assigned system functions or scripts.

PLC code view
The "PLC code display" object is used to display the current program status of user programs 
that have been programmed in the graphical programming languages LAD and FBD as well 
as GRAPH.
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System diagnostics control
The view type for the system diagnostics control object has been extended by the "Distributed 
IO view".

The "Distributed IO view" shows the distributed devices of the Profinet IO system.
The requirement is that only one PLC is configured with a Profinet IO system. Otherwise, 
Runtime switches back to the matrix view.
The "Home" button allows you to switch from the distributed IO view to the diagnostics 
overview. You can also jump to the diagnostics buffer from the distributed IO view.
If the Profinet IO system cannot be accessed, the diagnostics overview is displayed.
If you change the device version from 18.00.01.01 to 18.00.01.00, the matrix view is 
displayed and the distributed IO view is not visible in the selection field.

4.5.5.5 Communication
This update contains improvements for:
• Process communication
• OPC UA communication

SIMATIC S7-1500 Software Controller V30.0
Version V30.0 of the SIMATIC S7-1500 Software Controller is introduced with the update.
• Create a direct, integrated connection between a Software Controller and the HMI Runtime 

of a WinCC Unified PC by dragging and dropping a Unified PC on to Software Controller in the 
"Devices & Networks" editor.

• Configure the PC/PC interface in Microsoft Windows by assigning the S7ONLINE access point 
to the RT-VMM virtual network adapter.

• In the "Devices & Networks" editor you create connections to other PLCs, direct or routed.
You use the S7ONLINE access point to create a direct connection between the HMI Runtime 
and an external PLC.
You use the VMM Adapter access point to create a connection between the HMI Runtime and 
an external PLC via the Software Controller. 
Depending on the number of interfaces on the Software Controller, you can configure several 
of these connections in different subnets.

• Configure a connection between an HMI Runtime and a Software Controller if both devices 
are created on different PCs.
To do this, assign the VMM Adapter access point to the HMI Runtime.
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OPC UA
Unified OPC UA clients can now address OPC UA server tags with an address of up to 256 
characters.
Application example: Addressing elements of a nested UDT.

4.6 Unified Engineering

4.6.1 Improvements in Update 5
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

4.6.2 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Faceplates
The system functions of the category "Tag > Jog mode" are only available for faceplates as of the 
lowest device version 18.0.0.2. 
System functions for jog mode:
• ReadAndIncreaseTag
• ReadAndInvertBitInTag
• ReadAndResetBitInTag
• ReadAndSetBitInTag
• ReadAndSetTagValue
• ReadAndDecreaseTag
When using with a lowest device version or lowest Runtime version, an error is output during 
compiling and loading.
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Tags in the global search 
After deleting a tag which is used in a dynamization the tag name therefore remains available 
in the dynamization and is highlighted in red. The tag is found in the global search and can be 
replaced.

Dynamic SVG graphics and own Controls
Dynamic SVG graphics are displayed correctly when copying a project to another device and 
displayed in Runtime.
Dynamic SVG graphics and My controls are displayed correctly in the screen after updating.

Logging
The logging mode of log tags "On change" functions flawlessly.

Indirect assignment of the address when multiplexing
When multiplexing via an array the indirect assignment of the address (DBNumber, Address) via 
a tag functions flawlessly.

Edit tag of parameter set types
Initial situation: You have configured a PLC user data type (UDT) which contains an element of 
the data type "String" and an HMI user data type which contains an element of the data type 
"WString" with a defined length.
If you configure a parameter set type which uses the PLC UDT as the data type and the HMI 
UDT as an editing tag, no error is displayed anymore if the string lengths match.

References in global definitions
The scripting of global references has been improved. References remain during copying, 
inserting and moving of code.

Characters of the font "Siemens TIA Portal Icons"
Entry of the ASCII characters of the font "Siemens TIA Portal Icons" via the keycode functions 
correctly.

Global search: Creation of the search index
The creation of the search index for the global search in the project functions flawlessly.

Compiling and loading changes
The compiling and loading of changes has been improved.
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Alarm control
Renaming the column name in the right part of the Inspector window in the column "Column 
header - Text" functions correctly. 

Sorting alarms:
When sorting discrete alarms according to the "Trigger tag" column, the results are displayed 
correctly in alphabetical order. 

Error in the synchronization of IDs when downloading projects
Synchronization of IDs has been improved to prevent erroneous ID conflicts when the project is 
downloaded. If an existing project has already been affected by this error, perform the following 
steps:
1. Download the complete project.

The project download fails. The ID database is updated.
2. Compile the project.
3. Download the complete project again and select the option "Do not synchronize" under 

"Synchronize IDs".
The project is downloaded completely. The IDs with errors are overwritten.

When you have performed these steps, you can download your project after the next change 
as usual and select any option for synchronization of the IDs.

TIA Portal Openness
The automatic creation of screen objects with the Excel importer has been improved. The 
"Authorization" object property is imported and assigned correctly.
The feedback for using non-allowed characters when renaming a faceplate instance via the 
Openness interface has been improved. 
The tag "TagTableName" of an HMI tag shows in the TIA Openness Explorer the correct value 
now instead of the name of the tag group.

4.6.3 Improvements in Update 3

4.6.3.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.
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Upgrading the device version of types
You can upgrade the device version of faceplate types or script module types, even if the type 
has been created in V18 or V18 Update 1 using the "Duplicate type" command.

Ports in topology view
The label of the ports of HMI devices in the topology view is displayed correctly.

Global search
The "Search in project" function in the global search has been improved.

Scripting
Use of the "\" character within tag names in scripts no longer leads to undesirable program 
behavior.
When a script module is used in an event list and converted to JavaScript, the "try... catch" 
instruction is now created correctly.
The references of faceplate types are displayed correctly in the "Scripts" editor.
Behavior when downloading script changes has been improved.

Copying global definitions
When copying multiple objects that use the same global definitions in scripts, the global 
definitions are not inserted more than once.

Number of tags
The number of PowerTags and the tags used is now correctly specified when compiling.

Scheduler: Using master copies
The copying of tasks from the Scheduler to the master copy of the project library is now possible 
without errors.

Cross-references
The cross-reference information has been improved. 

View of Things
The rotation of dynamized objects is displayed correctly in Runtime.
Synchronous functions of an array, e.g. array.find, array.some, array.any, etc., are transferred 
from the WebWorker to an asynchronous version and can be used.
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SiVArc
The generation of the position of faceplates has been improved.
The positioning of screen objects that is generated after a manual change to the screen 
objects has been improved. 

4.6.3.2 Screens and screen objects
This update contains the following improvements and changes:

Configuring screens
The display of IO fields has been improved. 
If you move objects between layers, they are displayed correctly in the editor.
The moving of individual objects in a group has been improved.
Size and position of objects can be changed correctly even after a rotation with the mouse.  
You have placed objects in a screen for Unified PC outside the area visible in Runtime. The 
behavior of the focus when changing the size one of these objects or moving the object to 
the visible area has been improved.
The behavior of transparent graphics and graphic views with transparent background has 
been improved.
The width of the columns of a trend companion can be projected in the Inspector window.
For the objects from the "My controls" area, the display with rounded corners has been 
improved. 

Bar
The subdivision lines of a bar are displayed correctly according to the settings in the properties.

Gauge
The color of the title is displayed correctly after the change of the configured foreground color.

Configuring IO fields
To define the behavior of the object in runtime, you select one or more of the following options 
under "Properties > General > Miscellaneous > Reaction to input":
• "Clear last value on focus". The last value is cleared when the IO field is selected.
• "Input on activate". The IO field changes automatically to input mode and allows an input to 

be made when the IO field is selected.
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• "Accept value after exit". The entered value is applied to the process value on exiting the IO 
field.

• "Hidden input". If "Hidden input" is active, the IO field displays the substitute character "*" in 
place of the entered character. You can use the hidden input for the entry of a password, for 
example. The data format of the value entered cannot be recognized.

Screen window
The automatic generation of a screen window by dragging and dropping a screen from the 
project tree has been improved.
Resizing using "Fit window to screen" has been improved.

System diagnostics control
The display of the system diagnostics control is retained when the "Multiple" property is selected 
in "General > Diagnostic view > Selection - mode".

SVG graphics
The display of SVG graphics has been improved.
The insertion of SVG graphics in the work area has been improved.

Faceplates
The working with styles in faceplate types has been improved. In the editor, all available styles 
are made available for selection.
The "Go to library version" function is now possible for the inner faceplate type even if the 
outer faceplate type is opened read-only.
When using the "OpenFaceplateInPopup" method, the reference to the faceplate type is no 
longer lost when versioning the faceplate type. The version number is adjusted correctly in 
the script.
The behavior of events on objects in faceplate types has been improved.
The text boxes font is retained when upgrading the device version in the faceplate type.
When copying faceplate types with text boxes from a multilingual project to a new project, 
the project languages must be taken into account. If the project languages are not created in 
the new project before copying the faceplate type, texts can be lost.
Multilingual texts in the interface properties of a faceplate instance are retained after 
upgrading the device version.
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4.6.4 Improvements in Update 2

4.6.4.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Dynamic SVG graphics
In French, the selection of dynamic SVG graphics is also possible via the file selection dialog.

I/O field
In Italian, the name of a newly created I/O field is displayed correctly.

Import of text lists
The import of a text list with parameter fields has been improved.

Faceplates
The specification on the designation of interface tags has been modified. Names that start with 
an underscore are not permitted any more.

4.6.4.2 Screens and screen objects
This update contains the following improvements and changes:

Transferring object properties
The visual highlighting of properties whose value differs from the specified style is also set 
correctly when properties are transferred using the "Transfer format" function.

"Layout" task card Scroll bar adjusted
When selecting an object in an image, the object is also focused correctly in the "Layer" palette 
in the "Layout" task card.

I/O field
The display of I/O fields has been improved.
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Information has been added for the option "Use indirect addressing" or "Read only" in the 
"Tag > Settings" area:
• "Use indirect addressing": The configured tag of the "WString" data type must contain the 

name of another tag as text.
• "Read only": The change to the property value is not applied in the tag.
The "Read only" option is enabled by default.

Trend control
For trend control, set the desired time zone under "Properties > Properties > Miscellaneous > 
Time zone" by entering a decimal value for the time zone. 
• "0" and positive numerical values: The values correspond to the index values of the Microsoft 

time zones.
• "-1": The local time zone of the device.
You can also set the time zone via a selection list in Runtime.
The legend is positioned in the same way in different trend controls, even under the 
following conditions:
• More than one trend area is configured.
• The first trend area in a trend control is set invisibly.

SVG graphics
The display of SVG graphics has been improved.

Dynamization with scripts
Editing of scripts created simultaneously for multiple objects has been improved.

Faceplates
When configuring a faceplate instance in a device with a predefined style, such as "Dark style", 
the faceplate is displayed correctly in this style.
When referencing faceplate types, spaces and dots within the faceplate name with 
underscores must be replaced. Reference faceplate types with full version number, for 
example: "Faceplate_1_V_0_0_1"
For faceplate types with the lowest device version V17.0.0.0 or V17.0.0.1, it is now possible 
to use user data types that were previously not permitted in TIA Portal V18 because they 
contain elements of an invalid data type. Access to the individual elements with an invalid 
data type is not possible. A corresponding error message is shown.
It is possible to upgrade the lowest device version of faceplate types in the project library 
or global libraries.  You can upgrade individual or multiple faceplate types in parallel. To 
upgrade multiple faceplate types, you can also select folders or libraries. If a duplicate of 
the faceplate already exists with the specified lowest device version, the existing duplicate is 
retained. If faceplates are used in other faceplates with a lower device version, their lowest 
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device version will also be upgraded to the new lowest device version. The function for 
updating faceplates in the project library or global libraries also takes into account the lowest 
device version.
When creating a new faceplate type, the device version is set correctly.

4.6.4.3 Logical operators for expressions

Introduction
To dynamize object properties, tags can be linked in an expression by logical operators.

Input values for logical operators
The following applies to the input values for logic operations:
• Value 0 = FALSE
• Value not equal to 0 = TRUE
You can find the results of expressions with various values and operators in the tables below.

Defining the evaluation order
The parentheses define the evaluation order. The expression inside parentheses is evaluated 
first.
Examples:
• (TRUE OR FALSE)AND TRUE => (TRUE)AND TRUE => TRUE
• TRUE OR(FALSE AND TRUE) => TRUE OR(FALSE) => TRUE

Operator AND
Expression Result
TRUE AND TRUE TRUE
TRUE AND FALSE FALSE
FALSE AND TRUE FALSE
FALSE AND FALSE FALSE

Operator OR
Expression Result
TRUE OR TRUE TRUE
TRUE OR FALSE TRUE
FALSE OR TRUE TRUE
FALSE OR FALSE FALSE
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Operator NOT
Expression Result
NOT TRUE FALSE
NOT FALSE TRUE

When dynamizing an object property with the "NOT" operator, put the expression you want 
to negate in parentheses, for example, NOT( 'HMI_Tag_7' ).

Operator XOR
Expression Result
TRUE XOR TRUE FALSE
TRUE XOR FALSE TRUE
FALSE XOR TRUE TRUE
FALSE XOR FALSE FALSE

4.6.5 Improvements in Update 1

4.6.5.1 General improvements 
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Special characters in the installation path
Even when the installation path contains special characters, objects are always visible when 
inserted into a screen.

Upgrading a device version in the library 
The update provides you the possibility to upgrade the device version of faceplate types and 
script module types in the library.
To upgrade the device version, follow these steps: 
1. Select a faceplate type, script module type, or folder in the library. 
2. Open the shortcut menu and select "Upgrade device version".

The "Upgrade device version" dialog box opens.
3. Select the required device version under "Lowest device version". 
4. Select "OK".
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Faceplates
Arrays are not supported when using the HMIUDT, WString, and WChar data types on the "Tag 
interface" tab of faceplate types. Therefore, the "Array limits" option has been disabled for these 
data types.

4.6.5.2 Screens and screen objects
This update contains the following improvements and changes:

Screen management
In the "Devices" area of the project tree, you can find a new "Screen management" folder. 
You can create exactly one top-level screen window with screen management. For the 
top-level screen window, select a screen from the ones available. 
You configure all properties of the top-level screen window in the Inspector window.

Zoom&Scroll for top-level screen window
For a top-level screen window, configure the following properties in particular:
• Zoom factor
• Position and visibility of the vertical scroll bar
• Position and visibility of the horizontal scroll bar 
You configure the properties:
• In the screen editor of the top-level screen window
• In the Inspector window of the screen, with a screen window under:

– "Properties > Properties > Format > Zoom - factor".
– "Properties > Properties > Format > Horizontal scroll bar - position".
– "Properties > Properties > Format > Vertical scroll bar - position".

In the engineering system, you dynamize the properties using tags or scripts. 
You can use the dynamic properties to control the behavior of the screen in runtime.

Resize to display
In the project, you can swap one device for another device with different display size. To adjust 
the configured screen size to the size of the new target device, use the "Resize to display" 
function:
1. Select the screen in the project tree.
2. Right-click on the screen. The shortcut menu is opened.
3. Select "Resize to display".
The configured screen size is adapted to the size of the new target device.
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Extension of the toolbar in the screen editor
To efficiently configure the frequently used properties, the following functions have been added 
to the toolbar in the screen editor: 

• Font:
– Font
– Font size
– Format bold font
– Format italic font
– Underline
– Strikethrough
– Increase font size
– Decrease font size

• Horizontal text alignment:
– Left
– Centered
– Right

• Specify border width or line width
• Line type:

– Solid
– Dashed
– Dotted
– Dash-dot
– Dash-dot-dot

The added functions are disabled for grouped objects when a group is selected.
The functions are enabled when a property in one or more objects can be changed.

Highlighting and resetting properties of screens and screen objects 
You can set one of the three pre-defined styles in the project tree of the project in the runtime 
settings. 
Within the selected style, you can change some properties of screens and screen objects in 
the Inspector window, for example the background color. 
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To find the changed properties, follow these steps:
1. Click on the "Filter" icon.
2. In the "Static value" column, select "Different from Style value".

All changed properties are displayed and are formatted bold in the "Static value" column.
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To reset the changed property value to the default value of the selected style, follow these 
steps:
1. Right-click on the property. The shortcut menu is opened.
2. Select "Reset property value". 

The property value is reset to the default value of the selected style.
You can reset the following properties:
• Manually set properties.
• Properties that have a corresponding value in the current style.
The properties that do not have a style value are not formatted bolded or displayed in the 
filter, even when they are set manually. 

Optimizing the display of properties
The overview in the Inspector window under "Properties" has been improved with the update. 
For properties that contain a collection of objects, the following changes have been made for the 
expandable table:
• Cells without content are displayed in space-saving manner.
• Check boxes and numeric values are displayed centered.
• Modified sorting of the columns is saved across projects.
• Modified visibility of the columns is saved across projects.
The "Selection items" table of the "Check box" element and the "Trend areas" table of the 
"Trend control" control are affected.
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4.7 Unified PC

4.7.1 Important notes
This page contains important information about product properties.

Script debugging
If you use a script debugger and want to display the time stamp of a tag or an alarm in the 
monitoring window, only the type of the script variable "HMIDatePrecise" is visible. The time 
stamp itself is not visible.
To display the time stamp, convert the script variables that contain the time stamp with the 
command 
myTag.toString();

Loading the logon page
If you experience display problems in the web client after you install the update, completely 
delete the browser data (history, form entries, etc.).  

Microsoft Edge - Restriction
If you want to start Runtime in Microsoft Edge and enter the address "https://localhost", the error 
message "INET_E_RESOURCE_NOT_FOUND" appears. In this case, use the address "https://
localhost/WebRH".

Project operations
The stability of project operations has been improved. Connection Manager now loads libraries 
from the correct path.

Bar and slider
If the height is smaller than 100 px and the width is smaller than 30 px for the controls "Bar" and 
"Slider", the Controls in the Engineering System and in Runtime are displayed as rectangles in 
light and dark types in compact mode. The values, bars and indicators are also displayed 
correctly in compact mode.
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Alarm control
• An alarm with the state machine "Alarm without inactive state without acknowledgment" is 

only displayed in the "Show logged alarms" and "Show and update logged alarms" views.
• The "Information" alarm class has the state machine "Active", which defines an alarm without 

state. The alarm is therefore triggered immediately and deleted. When the value is evaluated, 
all bits are evaluated; in the case of bit [0] and bit [2] this means that the alarm is triggered 
even though only bit [2] is changed - the entire value is evaluated.

• The "Alarm filter" dialog box does not support brackets in the text area.

WinCC Unified Tag Simulator
The WinCC Unified Tag Simulator is not part of WinCC Unified V18 and its updates.

Script debugger
To activate the script debugger in SIMATIC Runtime Manager, the logged-in user must belong to 
the "SIMATIC HMI" Windows user group.

Unified Collaboration
Collaboration devices must be synchronized in time.

Record / Play function
When using the Record/Play function, the runtime system settings made during installation or 
later in WinCC Unified Configuration Manager are not recorded.
Silent installation of Runtime via the Record/Play function is not supported. 

Changing user management settings
If you change the user management settings during installation or later in the "User 
management" step in the WinCC Unified Configuration, a self-signed web server certificate is 
generated and bound to the website when the settings are applied. It replaces the certificate that 
was previously bound to the website. If a trust relationship existed between the web server and 
clients, the clients no longer trust the web server.
To revert back to the previously used web server certificate, proceed as follows: 
1. Start WinCC Unified Configuration.
2. In the "Website settings" step, select the "Select an existing certificate" option.
3. Select the previously used certificate.
4. Apply your settings.
The certificate is now bound to the website. 
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Repair installation
If you upgrade an HMI device with WinCC Unified Runtime V18 Installation to V18 Update 3 and 
perform a repair installation for V18 at a later point, this is terminated with an error.
Follow these steps:
1. Uninstall V18 on the device.
2. Install V18 on the device.
3. Upgrade the device to V18 Update 3.
Currently there is no scenario which requires a repair installation after upgrading to V18 
Update 3.

Reporting: Creating a report template
In the configuration of the logging tags of a single value segment you configure which date and 
which time the log entry has with the settings "Time stamp" and "Calculation mode" whose value 
is then read in from Runtime:

Calculation mode Read-in value
Left The value of the log entry that precedes the time determined by the "Time stamp".
Right The value of the log entry which was logged at the time determined by the "Time stamp".

If there is no log entry with this time stamp, the value of the log entry is read that succeeds 
the time determined by the "Time stamp".

Interpolate The values which the calculation modes "Left" and "Right" supply are interpolated linearly 
and the result is written into the report during generation.
This mode can only use values of log entries with a valid quality code.

If the time stamp of the log entry is also output in the report, the time stamp of the log value 
actually read in is applied for the calculation modes "Left" and "Right". The time determined 
by "Time stamp" is used for the "Interpolated" calculation mode.

Connecting with a Runtime system via the ODK
If you want to connect with a Runtime system via ODK, use the collaboration name of the HMI 
device.

SIMATIC Runtime Manager
• Opening several SIMATIC Runtime Manager instances on the same device is not supported.
• Do not change the user logged in to Windows while a Runtime Manager instance is open. 

4.7.2 Improvements in Update 5
This update contains the following improvements and changes:
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Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

4.7.3 Improvements in Update 4
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Data logging
Negative effects on the performance of Runtime through the use of tag logging have been 
resolved.

Reports 
Time format for LTime tags in reports
If a single value segment of a report template reads a tag or logging tag of the type LTime, 
you can now specify in the report template in which time format the tag value is output in 
the generated report. 
Follow these steps:
1. In the report template, read the Runtime data into Excel once.
2. Format the time value read into the cell as required.
When the report is generated, the formatting is retained.

Quick generation
The generation of reports has been improved. Reports with 1000 or more single value 
segments and with single value segments to which graphic lists are assigned are now 
generated more quickly.

Defining the timeout
You have the option of defining a timeout for the generation of reports in PDF format:
1. Open the following file:

<Unified installation directory>\bin\REPCreator\js\installerConfig.json
2. Add the attribute "timeout" and a time value in milliseconds to the entry in the file.

Example: {"useApp": "Excel", "path": null, "timeout": 60000}
The timeout applies to all report jobs with the target format PDF. If the timeout is exceeded, 
the generation is canceled. A status message is generated in the control.
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External database access via script
A storage leak when accessing an external database via script has been resolved.

Deleting projects in SIMATIC Runtime Manager
When deleting a project in Runtime Manager the user alarm and information bar now show the 
correct text.

GraphQL
When accessing a GraphQL client on a Control, the client now also transfers users with which the 
client is logged on to Runtime.
This enables you to access a Runtime project with the GraphQL client whose user 
administration data was loaded previously, independent of the current Runtime project.

Localized strings in faceplates after a language change
After a language change in Runtime, localized texts in faceplates are now displayed in the right 
language.

Reading nested user data types with ODK
Instances of nested user data types are now read correctly.

Parameter set control
The selection boxes in the parameter set control function flawlessly.
After switching languages in Runtime, the parameter set names are displayed correctly.
The property "Operator control - allow" for columns is applied correctly to Runtime.

Alarm control
The most recent logged alarms are displayed correctly.
The display of the alarm control has been improved.
The configuration of the column width in the alarm control has been improved. Alarms and 
texts of the header are displayed correctly.
Logged alarms are displayed correctly.

Time synchronization between HMI and PLC
The alarms "partner requires correction of timing" are triggered when the time stamp of the 
times delivered by the I/O devices (S7, S7+, OPC UA) deviates by more than 3 seconds from the 
time of the HMI device and as a result must be corrected. 
The faulty occurrence of the alarms has been solved. The alarms may legitimately occur after 
a foreseeable time (3 days).
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PLC code view
Scrolling in the PLC code view functions correctly.
Constants in the footer and header areas of the comparison operations in the PLC code view 
are displayed correctly. The value comes first, followed by the name of the constant.
The display of the PLC code view has been modified and the networks are displayed correctly.
Value changes to the PLC block are transferred directly into the PLC code view. 
Parameter names are displayed in full in the PLC code view.

Faceplate in main screen window
Faceplates are displayed correctly in the main screen windows if the setting "Fit screen to 
window" is set for the main screen window.

Screen keyboard on touch devices:
Screen keyboard on a touch device is correctly displayed after activation through an I/O field.

Calendar format
After switching the Runtime language from English to German the first day in the calendar is 
shown as Monday. 

Text box
The text in the object is correctly displayed in the Engineering System and in Runtime 
independent of how the static value is set in the property "Format > Alignment - vertical".  

Symbolic I/O field
The scroll bars in the symbolic I/O field function correctly.
The scroll bars in the symbolic I/O field are correctly displayed independent of how the static 
value in the property "Format > Distance > Position - Left" is configured for the symbolic I/O 
field.

Bar and slider
The controls "Bar" and "Slider" are displayed in the Engineering System and in Runtime in 
extended, light and dark styles and correctly displayed with all modes of the process value 
indicator.
The controls "Bar" and "Slider" are displayed correctly in the Engineering System and in 
Runtime in compact mode.

Trend control
Session local tags are correctly displayed in the trend view.
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Archive tags are correctly displayed in the trend view.

Browser
If the control is opened in a popup window, the URL is displayed correctly in the browser. 
Popup windows are correctly displayed in the "Browser" Control in accordance with the size 
change of the browser.

Dynamization of the visibility of the levels
The dynamization of the visibility of the levels via expressions functions correctly.

Text alignment in the object "Text"
The text alignment after a line break in the object "Text" is consistent between Engineering and 
Runtime. 

Flashing during color dynamization
The flashing during color dynamization starts without delay.

Access point for the communication with PLC
During the definition of the access point of the application in the dialog "Set PG/PC interface" and 
during the configuration of the connection of an HMI device to a PLC in the Engineering System 
you can now also use two letters as identifier for the access point of the application. 

Export of data in Audit
The data export in Audit takes place without errors.

View of Things
The tag value of the data type "Time" is transferred correctly from an I/O field in the VoT 
application into the PLC.

Time synchronization between Runtime and PLC
The alarm with the ID 537526277 "partner requires correction of timing" is triggered when the 
time stamp of the times delivered by the I/O devices (S7, S7+, OPC UA) deviates by more than 
3 seconds from the time of the HMI device and as a result must be corrected. 
The faulty occurrence of the alarm has been resolved. The alarm may legitimately occur after 
a foreseeable time (3 days).
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4.7.4 Improvements in Update 3

4.7.4.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Continuous operation with Edge
It is possible to use Microsoft Edge as a Web client in continuous operation.

Substitute font not installed
If a font that is not installed on the HMI device was configured in the engineering system, 
Runtime uses the substitute font instead.
If the substitute font is not installed on the HMI device, the download to the device fails and 
a corresponding error message is generated. 

Popups
The display of popups in combination with the zoom function has been improved.

User management in Runtime
Logging in to the user management home page in Runtime works correctly regardless of 
whether "Runtime timeout" has been enabled or disabled for the user.

Scripting
If you have dynamized several screen objects in a screen with scripts with different triggers 
(events, properties, etc.), the dynamizations are also correctly implemented after a delta 
download. 
The functioning of subscriptions has been improved. If a subscription is triggered when a tag 
is updated, no additional scripts are run.
The output in the Trace Viewer has been improved. When script errors associated with 
writing and reading of properties occur, the call stack with module name, method and line 
number is output.
Traces in scripts that are triggered by a scheduled task are also displayed in the Trace Viewer 
if the script debuggers have been activated.
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Logging
If you work in MS SQL databases with SQL Server 2016 or higher, unused memory may be 
allocated instead of being used efficiently in the case of few write operations in the respective 
interval. 
In this case, activate "SQL Server Trace Flag 692" globally in the startup parameters for the 
installation of the MS SQL Server instance.

Scheduler: Multiple alarms
If multiple alarms are triggered, all alarms are listed in the return value "alarmResultArray".

Communication with Allen Bradley
Unsigned data types such as UINT, UDINT, USINT, and ULINT are transmitted correctly via 
Ethernet/IP.

Audit
The value change of a GMP-relevant HMI tag using the slider is correctly logged in the Audit Trail. 
When the "Comment required" and "Electronic signature" options are selected, correct values are 
displayed in the corresponding dialog.
The change of a tag of data type "Bool" using the "InvertBitInTag" function is correctly logged 
in the Audit Trail. 

Touch operation
The response times for user interactions on a touch panel have been improved.

4.7.4.2 Screens and screen objects
This update contains the following improvements and changes:

Font 
The font is displayed in the same way in the engineering system and in Runtime on Unified 
Comfort Panel and on Unified PC.

Displaying buttons after user change
The display of buttons has been improved. If the logged on user lacks the function right to 
operate the button and you switch to a user with the corresponding function right, the buttons 
are no longer grayed out.

Grouped objects
The dynamization of grouped objects is displayed correctly in Runtime.
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Zooming and scrolling
Improved behavior when zooming and scrolling in Runtime. Faceplates are only hidden when 
they are completely outside of the visible area.

Text field
The input of multi-line text with <Return> and <Shift + Return> in a text field in Runtime has been 
improved.

Gauge
The color of the trend indicator is displayed correctly.

Slider
The graduation marks are displayed correctly in Runtime regardless of automatic scaling.

Symbolic IO field
The behavior when scrolling in symbolic IO fields has been improved.

Alarm control
The sorting in the alarm control has been improved.
The display of archived alarms in the alarm control has been improved.
The operation of the vertical scroll bar in the alarm control has been improved.
The display of alarms when remotely accessing a Unified Comfort Panel has been improved. 
Alarms regarding a necessary correction of the reporting time of the partner device are 
output correctly.
Configured output formats such as {D} or {T} are also evaluated correctly if the "Time" and 
"Date" columns are configured with different output formats in an alarm display.

Trend control
The names of the axes can be read correctly via scripts. 
Trends are also displayed correctly after changing the time range.

Dynamic SVG graphics
After a delta download, renamed dynamic SVG graphics are displayed correctly in Runtime.

Faceplates
The use of popup windows has been improved. Static and dynamic content in popup windows 
are loaded correctly when opened.
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The function of the "Visible" object property when using faceplates in faceplates has been 
improved.
The change of the properties of popup windows by scripting is executed correctly.
PLC user data types that use data types "IP_V4" and "IP_V6" can be used in the tag interface of 
a faceplate type.

4.7.4.3 Parameter sets and parameter set control
This update contains the following improvements and changes:

Parameter sets
The "RenameParameterSet" system function has been improved.

Parameter sets and parameter set control
Parameter sets are correctly displayed after refreshing the web page.
The reading and writing of parameter sets has been improved.
The input of a time value of "LTime" type in the parameter set control has been improved. 
The correct time value is applied and defined limit values are taken into account.
A user data type with elements of type "String" or "WString" that have a defined character 
length can be used in parameter set types. The defined character length is correctly applied 
to the parameter set element in the parameter set control.
The import and export of parameter sets has been improved
The ID of the parameter set is retained in the parameter set control after a screen change.
Loading a parameter set using the "LoadParameterSet" method results in a correct reading of 
the values of the parameter set.
If you enter a value in a parameter set that is greater than the maximum value set, an error 
message is displayed.

4.7.4.4 Diagnostics
This update contains the following improvements and changes:

System diagnostics
The switching of the view in the system diagnostics display has been improved.
Error messages from ports are correctly displayed in the matrix view.
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Criteria analysis view
If the upstream network has been changed, the alarm is not be triggered again. This leads to 
inconsistencies between the network and faulty operands. As a result, the criteria analysis view 
cannot correctly display the faulty operands. If the alarm is triggered again, the faulty operands 
are displayed correctly again in the criteria analysis view.

PLC code view
The tag name and address of an operand connected to an SR/RS flip-flop are displayed correctly.
The display of sequencers in the GRAPH overview and PLC code view has been improved. The 
highlighting of the currently selected step is displayed correctly.

4.7.4.5 My WinCC Unified (Autologin)

Introduction
With the My WinCC Unified web application, you can define for a Unified PC how Runtime is 
displayed in its web clients. 
My WinCC Unified is rule-based. For each rule, you can define:
• For which client device the rule applies.

The rule is applied to all web clients that are installed on the client device and which log in 
to the Runtime of the Unified PC.

• Whether auto-login is active.
If auto-login is enabled, the web client can automatically log in to Runtime without entering 
a user name and password (auto-login).
A default user who has no function rights is used to log in. 

• Which start screen is displayed after logging in to Runtime.
• Further details on the display of the start screen (section, start point etc.)

Restrictions
• My WinCC Unified is only available for Unified PCs.
• If auto-login is active for a rule, it is not possible to operate objects or functions that are linked 

to function rights after the automatic login to Runtime.
• The client devices for which you create rules must have static IP addresses.

Requirements
The login to My WinCC Unified requires the function right of remote access.
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Installing My WinCC Unified on a Unified PC
1. Install the WinCC Unified Runtime V18 Update3 on the Unified PC.
2. Check whether the Unified PC in the engineering system has the configured Runtime version 

V18.0.0.2 or higher. 
If this is not the case, upgrade the configured Runtime version.

3. Reload the Unified PC into the device.
Note
This step is also required if the correct Runtime version has been configured in the 
engineering system.

Opening My WinCC Unified

Note
In addition to the above-mentioned requirements, which are specific to My WinCC Unified, the 
same requirements apply as for logging in to Runtime in a web client.

1. Start the web client.
2. Enter the URL of Unified in the address line of the browser: "https://<IP address of the HMI 

device or its FQDN or device name>".
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3. Press Enter.
The Unified home page appears: 

Note
If you do not see the "My WinCC Unified" entry on the home page, delete the browser data 
completely (history, form entries, etc.), and reload the page.

4. Click "My WinCC Unified". 
The application is opened in a new tab. You see the logon dialog.

5. Enter the user name and password of a user with the necessary function right and select 
another language if required.

6. Confirm your input.
My WinCC Unified is opened. In the navigation area, you can see the rules that have been 
added to the project running in Runtime.

Note
After login, My WinCC Unified has the user interface language that you selected during login. If 
you have not selected a language, the language that is set for the browser is used.
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User interface
My WinCC Unified has the following user interface:

① Search field
Filters the rules displayed in the navigator by the search string.

② Button
Opens a menu for the export and import of rules.

③ Toolbar:
Saves the changes to the rule currently loaded in the work area.

Adds a new rule in the navigator and loads it in the work area.
With the exception of the client settings, the new rule inherits the settings of the rule previously 
displayed in the work area.
Deletes the rule that is currently loaded in the work area.

④ Work area
Shows the rule selected in the navigator.

⑤ Navigator
Shows the added rules. The rules are sorted according to when they are added.
By clicking on a rule, you load it into the work area. 
By clicking "+ Add" a new rule is displayed in the work area. It starts with the default settings.
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Working with rules
You have the following options:

Add 1. Click "Add" in the navigator. The new rule is displayed in the work area. It starts with the default 
settings.
Or click in the toolbar . With the exception of the client settings, the new rule inherits the settings 
of the rule previously displayed in the work area.

2. Configure the settings of the rule as required as described below.
3. Click in the toolbar .

Duplicate 1. Load a rule into the work area.
2. Click in the toolbar .

With the exception of the client settings, the new rule inherits the settings of the rule previously 
displayed in the work area.

3. Configure the settings of the rule as required as described below.
4. Click in the toolbar .

Edit 1. Click a rule in the navigator. The rule is loaded into the work area.
2. If required, edit the settings of the rule.
3. Click in the toolbar .

Delete 1. Click a rule in the navigator. The rule is loaded into the work area.
2. Click in the toolbar .

Export 1. Click "..." in the navigator.
2. Select "Export".
All rules defined in the navigator are exported to a YAML file, in the download folder preset on the device.
If required, edit the file and import it to other client devices.

Import 1. Click "..." in the navigator.
2. Select the desired YAML file in the file browser and confirm your entries.
The rules from the file are imported into the navigator. 
If a rule has been defined in the file and in the navigator for the same client device, the settings are applied 
from the file.
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Settings
For each rule, you configure the following settings:

"Client settings"
"Client name" Mandatory field

The device name or FQDN (Fully Qualified Domain Name)
If the rule applies to the local web clients of the Unified PC, you can also enter "localhost".

"Client address" Mandatory field
The IP address
You have the following options:
• Enter an IP address or multiple IP address (e.g. 192.65.168.160 

or 192.65.168.160, 192.65.168.165). The rule applies to this device(s).
• Enter an IP address range (e.g. 192.65.168.160-192.65.168.190). The rule ap‐

plies to all devices in this address range.
• Combine these options (e.g. 192.65.168.160, 

192.65.168.165-192.65.168.190).

Note
Do not enter an IP address in multiple rules. 
If you enter an IP address in a rule and the IP address also belongs to the address range 
configured in another rule, the rule in which you entered the IP address is applied.
Examples of "Client address"
You define the following rules:
• 1st rule: "Client address": 192.65.168.165

Successfully saved.
• 2nd rule: "Client address": 192.65.168.160-192.65.168.190, 192.65.168.199

Successfully saved. For the display of Runtime on the client device with the IP address 
192.65.168.165, the 1st rule is applied.

• 3rd rule: "Client address": 192.65.168.199
Saving is not successful because the IP address is already entered in the 2nd rule.

"Start picture"
"Authentication" "Show start screen without login" option:

• Enabled: The web clients of the device are logged in to Runtime with a default user 
without user input. You automatically see the start screen that is usually configured.

• Disabled: The web clients of the device must enter their user name and password to log 
in to Runtime.

"Selected start screen" Select the start screen: You are offered all the start screens of the project running in Runtime.
"Apply current client session" If WinCC Unified Runtime is open in the same web client, click this button to apply the 

settings of the screen currently displayed in Runtime to the rule.
Button is disabled if more than 1 address or an address range is entered under "Client 
address".
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"Start picture"
"Resolution" The resolution configured in engineering

Read-only
"Screen area"
 

"Use the complete screen as start screen" option: The complete process picture is displayed 
as the start screen.
"Use a selected screen area as start screen" option: Only the area of the process picture 
selected under "Screen area" is displayed as the start screen.

"Screen area"  
"Zoom factor" Enter the zoom factor.

Default setting: 100%
"Start point X", "Start point Y" Enter the starting point of the upper left corner of the screen area to be displayed.

Default setting: 0

4.7.5 Improvements in Update 2

4.7.5.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Parameter sets and parameter set control
The selectable buttons of the function bar of the parameter set control remain selectable when 
changing the style in Runtime.
If flexible limits are violated when passing values to parameter set elements, a system 
alarm is output. The system alarm contains the name of the parameter set element and the 
corresponding limit.
The order of the elements of user data types in parameter sets is retained when parameter 
sets are exported.

Scripting
When a script dynamizes the "Change" property of the screen in a screen window, the return 
value "value" in the script correctly returns the screen name.
The "Add comment to log tag" script template has been improved. The comment is stored 
with the current system time in the "LoggedComment" table in the associated Runtime log 
file.
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The performance of the debugger during runtime has been improved. The GfxRTS 
application is not executed multiple times.

Runtime
• When logging on to Runtime with a UMC user, the language specified by UMC is displayed, 

and when logging on with the default user, the last language displayed in Runtime is 
displayed. When logging in for the first time with the default user, the default language for 
the project is used.

• Improved behavior when zooming and scrolling in Runtime. Faceplates are only hidden 
when they are completely outside of the visible area.

• When you zoom in a Chrome or Edge web client, the texts are now also correctly enlarged or 
reduced.

• After the installation of the update, the functionality of PLCSIM is restored after a change of 
the Windows user.

• The behavior when moving objects has been corrected.  Runtime clients remain operable 
when you move an object in runtime while a script disables the "Moveable" property.

• The predefined session local tags @CurrentLanguage, @LocalMachineName and 
@UserName are now read or set correctly even after stopping and restarting Runtime.

• If a button is pressed and a screen change takes place at the same time, the event configured 
for "Release" is now triggered.

Reporting
Report jobs with a tag trigger are now executed reliably if the trigger tag is connected to a tag 
from a third-party PLC.

WebClient
The display of user-defined fonts in text fields has been corrected.

OPC UA
The registration of tags on the OPC UA server has been optimized.

View of Things
Improved behavior when zooming. 

4.7.5.2 Screens and screen objects
This update contains the following improvements and changes:

I/O field
Entering information in I/O fields in Runtime has been improved.
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When a screen with a system diagnostics control is called in Runtime, entering values in I/O 
fields of type "Real" is no longer blocked. 

Symbolic I/O field
The display of symbolic I/O fields in Runtime has been improved:
• When expanding, symbolic I/O fields in faceplates and screen windows are now always 

displayed in full.
• After selecting an entry of a symbolic I/O field, the text is now displayed correctly.
• The transparent display of symbolic I/O fields in dark and light pre-defined styles has been 

improved.
• Non-operable symbolic I/O fields are now displayed correctly.

Alarm control
Sorting of alarms in logged alarms has been improved.
Scrolling in the alarm control has been improved.
The mouse icon is displayed correctly when moving the mouse in the grid area.
Scrolling in the alarm control has been improved.
Group acknowledgment is also possible for partially visible alarm lines.
The status of PLC alarms is displayed correctly in Runtime after acknowledgment.
If AutoScroll is active in alarm control, the scroll bars are disabled.

Trend control
The display name of the selected trend is displayed correctly after the trend is changed.
Automatic scaling in the trend control works correctly after changing the value axes.
The time zone is displayed correctly.

Touch area
The function of the touch area has been improved.

Gauge
The color of the title is displayed correctly in Runtime.
The color of the trend indicator is displayed correctly in Runtime. 
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Faceplates
The following changes have been implemented in the display of faceplates in Runtime:
• When switching from collaboration screens to screens with faceplates, the faceplates are 

displayed correctly.
• The dynamic color representation of dynamic SVGs in faceplates is displayed correctly.
• The behavior for displaying faceplates in pop-up windows has been improved.
• The scaling of faceplates in screen windows with several screens of different sizes has been 

improved.

Dynamization
When you click on a screen object in runtime, the click event is triggered only for that screen 
object and no longer for the screen. 

4.7.5.3 Diagnostics
This update contains the following improvements and changes:

System diagnostics
Changing the status in dynamic SVGs via the "DiagnosticsIndicatorTag" tag is now displayed 
correctly in existing projects.

System diagnostics control
When a screen with a system diagnostics control is called in Runtime, entering values in I/O 
fields of type "Real" is no longer blocked.
Improved the display of the status path when browsing the Matrix view to the diagnostic 
buffer on a PC.
Changing the view type via dynamization with a tag has been improved.
The display of the hardware detail view in the matrix view has been improved.
Improved column width customization in Hardware Detail view in Runtime.
Dynamization of the "Matrix view" view type in Runtime has been improved.

ProDiag overview
The "ProDiag Overview" object displays the correct network connection state.
Delta downloading is now also possible after changing the "DB name" property in the 
"ProDiag overview" object.

PLC code view
The display of the entire block when switching the detail view and after changing the style has 
been improved.

Improvements in WinCC Unified
4.7 Unified PC

Readme
106 Readme, 10/2024, A5E52423187-AE



The display of the GRAPH sequence with the "Time" data type after switching the GRAPH 
mode from step to transition has been corrected.
The initialization of the PLC code view via the "GRAPH overview" with the help of system 
functions "OpenScreenInPopup" and "OpenGRAPHViewerFromOverview" has been improved. 
The display of the GRAPH sequence in the graphical programming languages FBD and LAD in 
the "PLC code view" object has been improved.
The display of the FBD blocks in the "PLC code view" object using the system functions 
"OpenPLCCodeViewByFCCall" and "OpenPLCViewbyCall" has been corrected.
The display of the assignment in the network has been improved.
The operands are now displayed correctly with an address.

4.7.5.4 Audit
This update contains the following improvements and changes:

Audit 
The Audit Viewer control has been improved.
The deletion of the selected query in the audit query is executed correctly.
The "Sort columns" function in the Audit Viewer has been improved.
The "New Value" filter function in the Audit Viewer is executed correctly.
The column details of the time stamp exported by the Audit Viewer are displayed in "Date, 
time" format.
The function of the filters for audit queries has been improved.
The request for the electronic signature is performed correctly.
The query message is displayed correctly in the information bar.
The acknowledgment dialog for a button configured with the "InsertElectronicRecord" system 
function and a predefined text list is displayed correctly.
The export and import of the reason and the signature are executed correctly.
The "Reason" column contains correct information in the exported Audit Trail.   
The configuration for the use of electronic signatures is correctly evaluated in Runtime.
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4.7.5.5 Improvements in WinCC Unified Certificate Manager

"New certificate" dialog
In WinCC Unified Certificate Manager, the interface of the "New certificate authority" and "New 
certificate" dialogs has been improved. The dialogs now have tabs:
• "General" tab 

The general properties of the new certificate authority or the new certificate, e.g. name and 
name of the organization.

• "Security" tab
Security-related properties of the new certificate authority or certificate, e.g. cryptographic 
key length and lifetime.

The properties you can edit on the tabs depend on the certificate type. You can edit more 
properties in general certificates than in the other certificates.

General certificates:
Introduction
Certificate Manager now supports the creation of general CA-based certificates. A device 
added in Certificate Manager can have multiple general certificates.
Installing a general certificate on its device is not done with Certificate Manager.
Application examples 
• Protecting communication of custom applications

Examples: ODK applications for HMI devices, applications for other devices
• When using local web clients that log in with RFID and PM-LOGON: When creating the 

certificate that the PM-LOGON server uses to authenticate itself to its clients
Advantage 
• Secure communication as well as easy establishment of the trust relationship by installing 

the root certificate
• Automatic trust relationship if the device and its communication partner have the same 

certificate authority or the communication partner already trusts the root certificate of the 
certificate authority

Requirement
• WinCC Unified Runtime is installed on a PC.
• The PC serves as the certificate authority device for the CA-based communication of your HMI 

devices.
• A certificate authority has already been created on the PC in Certificate Manager.
• For an application created for Unified Panel to use the panel's general certificate, it must 

address the panel's certificate store.
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Using general certificates
1. Start WinCC Unified Certificate Manager on the certificate authority device.
2. If the device for which you want to create the general certificate is not yet part of the CA 

infrastructure, add it.
3. Then right-click on the device and select "Add Certificate > General...".
4. Enter the properties of the certificate in the "New certificate" dialog.

The following applies:
– You can use a template. To do this, enable the "Use template" option and select the 

template from the list next to it.
Note
Only 1 template is available in the current version.
Alternatively, you can duplicate a general certificate that has already been added and 
change the desired properties on the duplicate.

– "Security" tab, "Key usage" and "Extended key usage" fields: To add, delete or edit a usage, 
right-click in the field and select the desired command.

5. Prepare to install the general certificate on the device. Follow these steps:
– Right-click on the general certificate and select "Export certificate ...".

The "Export certificate" dialog opens.
– Select the option "Export with private key".
– To protect the use of the private key, assign a password. 

Note
To be able to use the private key, the target application must also provide this password.

– Specify the format for the export. Activate one of the following options for this:

"Export public certificate in DER format" Public key and private key are exported to a 
common PFX file.

"Export public certificate in PEM format" Public key and private key are each exported to 
a separate PEM file.

– Click "Export".
– Select the storage location and confirm your entry.

6. Transfer the file or files to the device. 
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7. Install the certificate private key and public key in the device's own certificates. Proceed as 
described in the user help for the specific device or application.
Note
If the device is a Unified Panel, install them in the certificate store of the panel. Use "Control 
Panel > Security > Certificates".
If the device is a Unified PC, the certificate store depends on the implementation of the 
application. It is possible to use the following certificate stores:
• Windows certificate store

Double-click the export file(s). Manually install the file(s) in the Windows certificate store 
to the appropriate folder.

• WinCC Unified certificate store, other file-based certificate stores
Copy the file(s) manually in a file explorer to the appropriate folder of the certificate store.

Installation with Certificate Manager is not possible

8. If necessary, establish the trust relationship between the device and its communication 
partner. 
Note
In the following cases, the communication partner already trusts the root certificate and thus 
also the general certificate of the device:
• The communication partner is an HMI device. The HMI device has the same certificate 

authority as the device. The certificate configuration of the HMI device is installed on the 
HMI device. 

• The device and its communication partner have different certificate authorities. The 
communication partner is already communicating with another device that has the same 
Unified certificate authority as the device with the general certificate.

Follow these steps:
– Export the root certificate and its CRL file in Certificate Manager on the certificate authority 

device.
– Transfer the root certificate file and the CRL file to the communication partner device.
– Install the root certificate on the device of the communication partner's in the Trusted 

Root Certification Authorities folder.
Proceed as described in the user help for the respective device.
If the communication partner is a Unified PC, use SIMATIC Runtime Manager for this. 
If the communication partner is a Unified Panel, use Control Panel > Security > Certificates.

Duplicate general certificates
1. In the "CA Configuration" tab, open a device that has a general certificate.
2. Right-click the certificate and select "Duplicate ...".
3. The "Duplicate certificate" dialog opens.
4. Edit the properties of the new general certificate as needed.
5. Click "OK".
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Export public key
1. In the Certificate Manager, right-click the general certificate and select "Export certificate ...".

The "Export certificate" dialog opens.
The "Export with private key" option is disabled.

2. Determine the file format of the public key to be used for the export. Activate one of the 
following options for this:
– "Export public certificate in DER format" 
– "Export public certificate in PEM format" 

3. Click "Export".
4. Select the storage location and confirm your entry.

4.7.6 Improvements in Update 1 Service Release 2
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

Screen keyboard in Runtime
Improved user experience when entering via the on-screen keyboard, e.g. when editing IO fields.

Zooming and scrolling in Runtime
Improved behavior when zooming and scrolling in Runtime. If an image contains faceplates that 
belong to a group, the faceplates are displayed until they are no longer part of the visible area.

Screen objects with Quality Code "Bad" in Runtime
Some screen objects, e.g. IO fields, visualize in Runtime with an exclamation mark in a yellow 
triangle if their quality code or the quality code of the tags linked to them has the value "Bad".
In rare cases, this visualization was incorrectly displayed in Runtime. This error has been fixed.

Reports
The layout of reports whose report templates have single value segments has been improved. 
If border settings have been made in the report template for a single value segment, the layout 
of the report generated in Runtime is identical to that of the report template.
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User interface language after refreshing the browser session
When refreshing the browser session, texts and graphics in Runtime are now reliably displayed 
in the correct language.

Subscribed PLC tags
The subscription of PLC tags was improved. Changes to the tags are now forwarded reliably to 
the HMI device even if only limited free resources are still available on the PLC.

4.7.7 Improvements in Update 1 Service Release 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved, among others, on account of the feedback 
received.

4.7.8 Improvements in Update 1

4.7.8.1 General improvements
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based on the feedback received and other 
factors.

Faceplates
Faceplates opened as a pop-up that enter the visible area due to changing the display in 
Runtime, e.g. enlarging the window, are now displayed. 

Trend control
The display of trends whose visibility is dynamized in runtime has been improved.

Alarm control
In alarms triggered by the "CreateSystemAlarm" system function, the alarm texts passed during 
the function call are displayed correctly in the alarm text column, regardless of which runtime 
language is set.
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Reporting 
If you configure a Unified PC in TIA Portal and select the value "Default" for the reporting database 
and the local main storage location, runtime uses the default storage locations configured 
during the runtime installation or later in WinCC Unified Configuration Manager. 
The correct default storage location is now also used in the following cases:
• After loading a Unified PC with configured Runtime version V17 on a PC with Runtime version 

V18 Update 1 installed
• After upgrading a Unified PC to V18 Update 1  

System diagnostics control
The display of hardware details in the matrix view for each port has been improved.

Display of the alarm control in the simulation
The display of the alarm control configured as an alarm line in the simulation has been improved, 
i.e. adapted to the display on the Panel. 

PaCo

Process diagnostics
The display of the sequencer during the jump from the GRAPH overview to the PLC code view has 
been improved.
The jump via the system function "OpenPlcCodeViewFromAlarm" into the corresponding 
GRAPH sequence has been improved.
When switching to the transition details in the "PLC code view" and "GRAPH overview" 
objects, the details are also updated after 3 minutes.
The objects of the process diagnostics indicate the correct status of the PLC.

Switch
The behavior of the switch when the status is dynamized via PLC tags has been improved.

4.7.8.2 GraphQL

WebSocket protocol for subscriptions
Subscription of alarms and tags with GraphQL requires the WebSocket protocol. 
The WebSocket protocol is not activated by WinCC Unified Setup. Activate the WebSocket 
protocol manually: "Enable or Disable Windows Features > Internet Information Services > 
WWW Services > Application Development Features > WebSocket Protocol".
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Escaping
Attribute values and object names, for example of tags or alarms, may contain special characters 
which are escape sequences in the Runtime system or the programming language of the 
GraphQL client. Escape sequences do not represent a text but start a special function during the 
program execution.
To ensure that a special character is interpreted as a normal character, prefix the character in 
the GraphQL client program code with a masking character (EN: Escaping).

Note
Masking character 
Runtime system: $
Apollo Studio: \

If a special character is an escape sequence in the Runtime system and the programming 
language, combine the masking characters.

Example
The character " is an escape sequence in the Runtime system and Apollo Studio. To, for 
example, address a tag with the name MOT1" enter the following string: MOT1$\"

Structure of the server response
The attributes delivered in the server response have the same sequence as in the selection set 
of the client query.

Subscription of tags during the delta download
If a GraphQL client subscribes to two tags and their tag names are renamed in a delta download 
such that the tags swap their names, the subscription is now executed further.

Security through access control
The access of GraphQL clients to Runtime can be restricted as follows:
• Linking access to function rights

An operation of the GraphQL client is only executed if the user who is logged on at the client 
has the required rights.
Reading rights are required for querying and subscriptions, and writing rights for mutations.

• Controlling access to the object level
The read access and write access of the user logged on at the GraphQL client is defined per 
object:
– Read access to an object without authorization: The object is removed from the server 

response.
– Write access to an object without authorization: The operation is aborted.
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Acknowledging and resetting alarms
You have the following options:
• Acknowledging or resetting all active alarms of one or more configured alarms.
• Acknowledging or resetting specific alarm instances of one or more configured alarms.

Note
Alarms without group acknowledgment or group reset
The configuration of a configured alarm can prevent a group acknowledgment or group reset. In 
this case you have to acknowledge or reset each alarm instance in an own operation call. 
The execution of acknowledgeAlarms and resetAlarms aborts when the operation for two 
or more configured alarms is called and one of the alarms does not allow group 
acknowledgment or group reset.

Requirement
• The user who is logged in to Runtime for the GraphQL client has the "GraphQL - read/write 

access" right in Runtime.
• The state machine of the alarms specified in the input parameter requires 

acknowledgement or acknowledgement and confirmation of the alarms.

Description "acknowledgeAlarms" and "resetAlarms"
acknowledgeAlarms(
      input: [AlarmIdentifierInput]
    ): [ActiveAlarm]
resetAlarms(
      input: [AlarmIdentifierInput]
    ): [ActiveAlarm]

Operation name acknowledgeAlarms resetAlarms
Operation type mutation
Function Acknowledges the active alarms specified in the 

input parameter input.
Resets the alarms specified in the input parame‐
ter input .

Input parameters input:
• Mandatory parameters
• Data type: [AlarmIdentifierInput]
• Specifies the alarms to be acknowledged or reset

Selection set Mandatory specification
Specify which attributes the server returns for the queried alarms. You can request the attributes 
defined in the ActiveAlarm type. 
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Server response Supplies the attributes requested in the selection set for the alarms as key-value pairs of a JSON data 
record.

Error messages (code 
and description)

• 0: Success
• 2: Cannot resolve provided name
• 304: Invalid object state
• 305: The alarm cannot be read / acknowledged / reset in current state
• x: Alarm instance does not exist

Data type "AlarmIdentifierInput"
The data type has the following attributes:
• name

– Mandatory specification
– The fully qualified name of a configured alarm

Alarm of a tag: <System name>::<Tag name>:<Alarm name>
Alarm of an element of a structure tag or array: <System name>::<Tag name>.<Element 
path>:<Alarm name>
Delimiter for the components of the element path: "."

– Data type: String
• instanceID

– Optional
– The ID of an alarm instance of the configured alarm
– If "0" is transferred as the instanceID or if no instanceID is transferred, all active 

alarms of the configured alarm are acknowledged.

Enabling and disabling alarms
You have the following options:
• Disabling one or more configured alarms 

The alarm condition of these alarms is no longer checked. No new alarm instances occur.
• Enabling one or more disabled configured alarms

The alarm condition of these alarms is checked again. New alarm instances occur again.

Requirement
• The user who is logged in to Runtime for the GraphQL client has the "GraphQL - read/write 

access" right in Runtime.

Description "disableAlarms" and "enableAlarms"
 disableAlarms(
      names: [String]
    ): [AlarmMutationResult]
 enableAlarms(
      names: [String]
    ): [AlarmMutationResult]
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Operation name disableAlarms enableAlarms
Operation type mutation
Function Disables the alarms specified in the input param‐

eter names.
Enables the alarms specified in the input parame‐
ter names.

Input parameters names:
• Mandatory parameters
• Data type: [String]
• The fully qualified name of one or more configured alarms.

The alarms are disabled or enabled.
Detailed information on how to specify the fully qualified name of a configured alarm, is available 
further up in the section on acknowledging and resetting of alarms > Data type "AlarmIdentifier‐
Input".

Selection set Mandatory specification
Specify which attributes the server returns for the queried alarms. You can request the attributes 
defined in the AlarmMutationResult type. 

Server response Supplies the attributes requested in the selection set for the alarms as key-value pairs of a JSON data 
record.

Error messages (code 
and description)

• 0: Success
• 2: Cannot resolve provided name

Data type "AlarmMutationResult"
The data type has the following attributes:
• alarmName

– The fully qualified name of the configured alarm
Detailed information on how to specify the fully qualified name of a configured alarm, is 
available further up in the section on acknowledging and resetting of alarms > Data type 
"AlarmIdentifierInput".

– Data type: String
• error

– Feedback on the success of the operation
– Data type: Error

Shelving alarms and canceling the shelving
Description "shelveAlarms“
shelveAlarms(
      names: [String]
      shelveTimeout: Timespan
    ): [AlarmMutationResult]
unshelveAlarms(

      names: [String]

    ): [AlarmMutationResult]
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Operation name shelveAlarms unshelveAlarms
Operation type mutation
Function Shelves the alarms. The 

attribute suppressionState of the alarms is 
set to 0x2 Shelved.
If the GraphQL client has subscribed to one of the 
shelved alarms, the client receives a notification 
on the shelving. 
The shelved alarms are still available and logged in 
the system. If the Graph QL client has subscribed 
a shelved alarm, it keeps receiving notifications on 
changes at the alarm from the Runtime system.
The implementation of the GraphQL client con‐
trols how the client:
• Deals with notifications about subscribed 

shelved alarms, for example. whether to sup‐
press them.

• Deals with operation calls that include shelved 
alarms, for example whether to disallow read 
access to these alarms.

Cancels the shelving of the alarms again. This cre‐
ates a log entry.

Input parameters names:
• Mandatory parameters
• Data type: [String]
• The fully qualified name of one or more configured alarms.

The active alarm instances of these alarms are shelved or their shelving is canceled.
Detailed information on how to specify the fully qualified name of a configured alarm, is available 
further up in the section on acknowledging and resetting of alarms > Data type "AlarmIdentifier‐
Input".

shelveTimeout:
• Optional
• Time interval after which the shelving of the 

alarms is automatically canceled.
Must not be greater than the timeout config‐
ured in Runtime. 
If no value is transferred, the timeout config‐
ured for Runtime is used.

• Data type: Timespan

-

Selection set Mandatory specification
Specify which attributes the server returns for the queried alarms. You can request the attributes 
defined in the AlarmMutationResult type. Information on the type can be found further above.

Server response Supplies the attributes requested in the selection set for the alarms as key-value pairs of a JSON data 
record.

Error messages (code 
and description)

• 0: Success
• 2: Cannot resolve provided name
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Subscribing to the redundancy status of the host
Requirement
• The user who is logged in to Runtime for the GraphQL client has "GraphQL - read access" 

rights or "GraphQL - read/write access" rights in Runtime.

Description "reduState“
Operation name reduState
Operation type subscription
Function Subscribes to the redundancy status of the host to which the connected GraphQL server belongs, in a 

redundant system.
Subscribes to the redundancy status of the host connected with the GraphQL client in a redundant 
system.

Input parameters -
Selection set Mandatory specification

Specify which attributes the server returns for the queried alarms. You can request the attributes 
defined in the ReduStateNotification type. 

Server response Supplies the attributes requested in the selection as key-value pairs of a JSON data record.

Note
Passive redundancy status
If the GraphQL client receives a notification that the status is passive, log off the client from the 
connected GraphQL server. Connect the client with the GraphQL server of the active host.

Type "ReduStateNotification" and "ReduStateValue"
The ReduStateNotification type has the following attributes:
value
• Data type: ReduStateValue
notificationReason
• Data type: String
The ReduStateValue type has the following attributes:
• value: 

The redundancy status as defined in the enumeration ReduState:
– ACTIVE

The host of the GraphQL server currently connected with the GraphQL client is active.
– PASSIVE

The host of the GraphQL server currently connected with the GraphQL client is passive.
• timestamp:

– Data type: Timestamp
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4.7.9 Improvements in Service Release 1
This update contains the following improvements and changes:

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Assigning text lists and graphics lists for reports
In a report template, when you map a text list or graphics list to the column of a data source item, 
the list values are now read correctly both in the add-in and when the report is generated.
For more information on this, refer to the user help on the Excel add-in under the keyword 
"Assigning text lists and graphic lists".

Symbolic I/O field in the "Output" mode
If a symbolic I/O field is linked to a resource list in "Output" mode, the applicable list entry is 
displayed. 

Loading from WinCC Unified Online Engineering
Stability of loading from WinCC Unified Online Engineering has been improved.

System tag "@CurrentLanguage"
The value of the system variable ""@CurrentLanguage is changed correctly even after a delta 
load when changing the Runtime language.

Contexts in the PI Option "Performance Insight"
Stability of archiving of PFI contexts has been improved:
• A memory leak has been corrected.
• Stability of context archiving after loading has been improved:

Error output
Crash in error output when accessing non-existent variables of a faceplate has been corrected.

Updating the browser
Stability on updating the browser has been improved.
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4.8 Unified Comfort Panel

4.8.1 Network settings

Network settings
The following table shows the network ports used by Unified Comfort Panel for internal and 
external communication. These ports must not be used for any other purpose.

Unified Comfort Panel
Name Port number Transport protocol
HmiRuntime 1234 TCP
HmiRuntime 1235 TCP
HmiRuntime 1344 TCP
HmiRuntime 4700 TCP
HmiRuntime 4701 TCP
HmiRuntime 4776 TCP
HmiRuntime 4777 TCP
HmiRuntime 4778 TCP
HmiRuntime 4999 TCP
HmiRuntime 5678 TCP
Snmpd 162 TCP
FwPnManager 34964 UDP

4.8.2 Important notes
This section contains important information about product properties.

Configuring connections
For the Unified Comfort Panel in the engineering system, only configure control connections 
that are also available and used in plant operation.

IP addresses
Regardless of whether SIMATIC Edge has been activated on the HMI device or not, the IP subnet 
172.17.0.0/16 is reserved for SIMATIC Edge communication. This IP address range must not be 
used for general network communication.
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Operating system downgrade and "Alarm persistency"
The following applies up to including HMI device image 18.0.0.4: If you perform an operating 
system downgrade to a lower major version (e.g. V18 to V17) and "Alarm persistency" is 
enabled, Runtime may not be able to start after the downgrade.
Proceed as follows for an operating system downgrade:
1. Under "Runtime Properties" > "Alarm persistency", deselect the "Enable alarm persistency" 

option.
2. Perform the operating system downgrade.
3. Activate the "Enable alarm persistency" option again.

"System Properties" > "Event Logger"
Only enable the Event Logger for a short period of time, as a large amount of data is recorded 
on the storage medium. If the remaining memory on the storage medium is greatly reduced, this 
can affect other processes that use the storage medium, e.g. alarm logging.

Important notes on storage media
Loading V18 Update 4 projects from external storage media
If you load a project created with V18 Update 4 (WinCC Unified) in the Control Panel 
via "Runtime Properties" > "Load project from storage", then the following applies: In the 
"Projects on external storage" list and in the "Project details" dialog, the "18.0.0.3" version is 
displayed under "RT Version".

Executing scripts
The execution of scripts from an external storage medium via the "StartProgram" system 
function is not permitted.

Ejecting a storage medium 
A storage medium can only be ejected safely via the system function "EjectStorageMedium" 
when the storage medium is not being accessed. Before calling up "EjectStorageMedium" 
ensure that no data transfer is taking place and that the storage medium is not being used by 
a function such as the "Trace Logger".

Operating system downgrade and alarm logging
Alarm logs created with a higher HMI device image version cannot be read or updated with a 
lower HMI device image version.
Example: Alarm logs that have been created with HMI device image V18.0.0.3 cannot be 
loaded with HMI device image V18.0.0.1.
In this case, the alarm control displays an error message regarding the incompatibility 
between database version and Runtime version.
After downgrading, use an empty storage medium for alarm logging.
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Status messages under "Network drive"
In the Control Panel of the HMI device, you manage a network drive that the HMI device can 
access under "Network and Internet" > "Network drive". The "Status" column of a network drive 
contains information about the connection status of the network drive.
The following table shows possible status messages, their meaning and possible solutions in 
the event of errors.

Status message Meaning Solution
Connecting The connection to the net‐

work drive is established.
 - 

Connected The network drive has been 
successfully connected.

 - 

No such file or direc‐
tory

The path specified under "Net‐
work Path" does not exist.

Make sure that the specified network path exists 
and check that the network path is entered cor‐
rectly in the "Network Path" input field.

Authentication failed The credentials are not correct. Make sure that the specified user has access to 
the network drive. Check the spelling in the 
"Username" and "Password" input fields.

Input/Output error The network drive cannot be 
connected.

Check the connection between the PC and the 
HMI device.
Re-establish the connection to the network 
drive. 

Inactive Appears after an operating 
system update because this 
process resets credentials for 
security reasons. 

Re-enter the credentials "Username" and "Pass‐
word" for the network drive.

Failed Is displayed when sharing of 
the network drive on the serv‐
er PC has been terminated.

On the server PC, check the network drive shar‐
ing settings and user access authorizations.

Timeout There are synchronization 
problems with the added net‐
work drive.

Check the connection between the PC and the 
HMI device.
Try reconnecting the network drive using "Edit" 
and "OK".

Notes on the "Edit user" dialog with image version 18.0.0.0
If you are using an HMI device image version 18.0.0.0 or higher, then observe the following 
information regarding the "Edit user" dialog of the local user management.
Cancel RFID assignment process
If you edit the RFID assignment of a user via the "Edit user" dialog and cancel the subsequent 
assignment process via the "Cancel" button in one of the dialogs, the entries in the user list 
may not be displayed correctly.
To update the list, select another entry in the navigation area of the Control Panel and then 
again "Security" > "User management".
RFID activation or PIN change logs the user in
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In the following cases, the selected user is logged in to the "Edit user" dialog immediately 
after the change operation:
• You have switched the "Enable authentication via RFID card" option from "disabled" to 

"enabled".
• You have switched the "PIN required for authentication with RFID card" option.
PIN dialog
In the following cases, the PIN dialog is displayed again after editing a user via the "Edit user" 
dialog.
• You have switched the "Enable authentication via RFID card" option from "enabled" to 

"disabled".
• You have switched the "PIN required for authentication with RFID card" option.
In this case, close the PIN dialog via the "Cancel" button.

Notes on the dialogs "Edit user" and "Add user" as of image version 18.0.0.1
If you are using an HMI device image version 18.0.0.1 or higher, then observe the following 
information regarding the "Edit user" and "Add user" dialogs of the local user management.

Cancel RFID assignment process
If you edit the RFID assignment of a user via the "Edit user" dialog and cancel the subsequent 
assignment process via the "Cancel" button in one of the dialogs, the entries in the user list 
may not be displayed correctly.
To update the list, select another entry in the navigation area of the Control Panel and then 
again "Security" > "User management".
When you assign a user an RFID login via the "Edit user" or "Add user" dialog, the "RFID 
assignment – Please hold RFID Card on connected Card reader" dialog is displayed with 
the "OK" and "Cancel" buttons. You start the RFID assignment using the "OK" button, you 
cancel the assignment with "Cancel". Depending on the dialog via which the assignment was 
started, the "Cancel" function behaves as follows:
• Assignment was started via "Edit user": "Cancel" closes the open dialog.

Result: You are back in the "Edit user" dialog and can make additional changes.
• Assignment was started via "Add user": "Cancel" closes the open dialog and the "Add user" 

dialog.
Result: You are back in the user list. The user was created without RFID login.

RFID activation or PIN change logs the user in
In the following cases, the selected user is logged in to the "Edit user" dialog immediately 
after the change operation:
• The "Enable authentication via RFID card" option is already enabled for this user and you have 

enabled the "PIN required for authentication with RFID card" option.
• The "Enable authentication via RFID card" option is already enabled for this user and you have 

disabled the "PIN required for authentication with RFID card" option or changed the PIN of the 
user. In this case, the PIN dialog is displayed again. Entering the PIN of the user and pressing 
"OK" logs the user in; pressing "Cancel" does not log the user in.
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Entering PIN immediately with PIN activation
If you select the "PIN required for authentication with RFID card" option for a user, enter a PIN 
in the "PIN" text box before pressing the "Edit user" or "Add user" button.

Editing data with PIN already assigned
If you want to edit the data of a user, such as the comment, and the "PIN required 
for authentication with RFID card" option is enabled for this user, the PIN must also be 
reassigned as part of the change. To keep the previous PIN of the user, you can enter the 
previous PIN again.

Network settings and "Restore"
Please note that the network settings of the HMI device such as the IP address can be overwritten 
if a backup with different network settings is loaded into the HMI device, e.g. via the "Restore" 
function or by inserting a system memory card that has been used for "automatic backup".

NTP server as of image version 18.0.0.2
The NTP server settings are deleted when HMI device image version ≤18.0.0.1 is updated to HMI 
device image version ≥18.0.0.2.
If you use one or several NTP servers, note down - before updating the HMI device 
image - the NTP server settings and enter them again in the Control Panel under 
"Language, Region and Formats" > "Date and time" after performing the update.

NTP server - "Update rate"
As of HMI device image version 18.0.0.3, the value for the synchronization interval with an NTP 
server ("Update rate") is entered via a selection list.

Secure HMI communication
The Unified HMI devices support Secure HMI communication in conjunction with a controller 
that also supports Secure HMI communication.
As soon as the HMI device is connected to such a controller, secure HMI communication is 
always used, regardless of the connection mechanism configured for the controller in TIA 
Portal.

Starting Runtime
You can start Runtime directly after loading a project or via the "Start Runtime" button in the 
Control Panel.
If background processes are running on the HMI device and Runtime is started at the same 
time, the dialog "Runtime Start" is displayed with the error message "An error occured while 
starting project".
Acknowledge the dialog and restart Runtime after some time.
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Browser download directory
On a Unified Comfort Panel, the browser download directory is: "/home/industrial/download"

Output directory for scripts in tasks
It is not permitted to write to the "home/industrial" directory via scripts in Scheduler tasks; use 
an external storage medium instead.

Using the central user management
The following sections contain important information on parameters of the "TIA User 
Management Component (UMC)".
Auto logoff time
The UMC parameter "Account Policy > Auto logoff time (minutes)" is not supported by Unified 
Comfort Panels. A user logged on to the Unified Comfort Panel must log off manually.
Must change Password
The UMC parameter "Status > Must change Password" is not supported by Unified Comfort 
Panels. Make sure that this option is disabled for all users of a Unified Comfort Panel.
Password duration (days)
An expired password cannot be changed on a Unified Comfort Panel. To log on a user 
whose password has expired, change the password directly in the "TIA User Management 
Component".

Resource-intensive SIMATIC Edge apps
The simultaneous operation of a runtime project and resource-intensive Edge apps can lead to 
performance losses.
Reduce the resource requirements of the apps as much as possible.

Notes on the apps under "Add-ons"
Restart the HMI device after switching over the display orientation
If you switch over the display orientation in the Control Panel under "System Properties" > 
"Display" > "Orientation" while one of the apps such as the Media Player is running on the 
HMI device, the content of the app may not be displayed correctly. To avoid this, restart the 
HMI device after switching the display orientation.
Playback quality in the media player
Depending on the load on the HMI device, the playback quality of videos in the "Media 
Player" app may vary. If the playback quality is inadequate, reduce the load on the HMI device 
as much as possible, e.g. by closing unnecessary apps.
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"Plant overview" control for Unified Comfort Panel not supported
With version V18, the "Plant overview" control is supported only for Unified PC. If you use the 
control under Unified Comfort Panel, an error message is output during compilation. The control 
must be cleared before compiling.

Important notes on ProDiag
Performance in Runtime
ProDiag occupies additional resources on the HMI device. This can affect screen opening 
times and performance in Runtime, such as loading the alarm control.

PLC user program
The following restriction applies for HMI device image version ≲18.0.0.3:
If you use S (Set) and R (Reset) outputs with supervision in your PLC user program, then 
permanent malfunctions of the process diagnostics handling in the HMI device may occur. In 
this case, Runtime or the HMI device must be restarted.
To avoid malfunctions, do not use S (Set) and R (Reset) outputs with supervision in your PLC 
user program.

Notes on the "PLC code view" control
Use PLC code view for evaluation only 
The PLC code view may only be used for evaluation, not in productive operation.

PLC code view style
The general Runtime setting "Dark style" is not suitable for the PLC code view. Choose a 
different style if you use the PLC code view object.

Notes on the "Media Player" control
Specification of the URL
In the "Media Player" control, you specify the URL for the desired file under "Properties > 
General".
To access a file, construct the URL according to the following scheme:
"file:///media/simatic/<storage location>/<file name>"
Example: "file:///media/simatic/X61/content/video.mp4"
Video formats
Video playback of .mp4 and .mkv files using the "Media player" control may result in 
performance decrease.
Use the .ogv or .webm formats instead.
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Alarm control
Flashing on range violation
Flashing on range violation is not supported for the alarm control.

Scroll bars
Scroll bars are not available in the alarm control. Use the touchscreen to move the contents 
of the alarm control horizontally or vertically.

"Show recent" button
The "Show recent" function is only supported in conjunction with ascending sort order.

Moving columns
Moving columns within the alarm control is not supported.

Status bar
If a text was configured for the first element in the status line and an image for the second 
element, the image may not be displayed immediately after loading. In this case, perform a 
screen change.

Filter alarms
Multiple selection of filter criteria is not supported in the filter dialog of the alarm control.

Dynamize visibility of columns
The dynamization of the visibility of columns via a script or a system function is not 
supported.

Parameter set control
If a parameter set control view was maximized and again reduced, it may happen that the view 
is not properly displayed. Elements such as parameter set type number or parameter set number 
may not be visible. Resize the width of the view once to properly display its contents again.

Trend control buttons
The "Move trend area" and "Move axes area" buttons do not work with HMI device image version 
18.0.0.2.
To move the axes, use the "Previous record"/"Next record" buttons or specify the desired start and 
end time with the "Select time range" button.
This limitation has been eliminated with HMI device image version 18.0.0.3 or higher.

Tag-related system functions at the "Press" and "Release" events
Affected system functions: "SetBitInTag"/"ResetBitInTag", "IncreaseTag"/"DecreaseTag", 
"SetTagValue"
If you have configured tag-related system functions on the "Press" and "Release" events of a 
button and the "Release event" follows the "Press" event in a period of less than 1 second, the 
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system function under "Release" may not be executed correctly. In this case, the affected tag 
value is not written to the controller.
To avoid this behavior, convert the tag-related system functions to the corresponding 
scripting functions using the "Convert function list to script" button ( ) and use the scripting 
function "Tags.Read" immediately after a write operation.
Example of "SetBitInTag"/"ResetBitInTag" at the "Press" and "Release" events:
Event "Press":
HMIRuntime.Tags.SysFct.SetBitInTag("<Tag_name>", 0);
Tags("<Tag_name>").Read(HMIRuntime.Tags.Enums.hmiReadType.hmiReadDir
ect);
Event "Release":
HMIRuntime.Tags.SysFct.ResetBitInTag("<Tag_name>", 0);
Tags("<Tag_name>").Read(HMIRuntime.Tags.Enums.hmiReadType.hmiReadDir
ect);
The example can be used in the same way for the other affected system functions.

Access to MS SQL and SQLite databases
In addition to Microsoft SQL, Unified Comfort Panels can also access SQLite databases. 
Databases must support the driver "Microsoft ODBC Driver 17 for SQL Server" of the version 17.9 
for Microsoft SQL or "SQLite3" for SQLite.

System diagnostics
If you upgrade a project with a diagnostics indicator from WinCC (TIA Portal) V18, V18 Update 1 
or V18 Update 2 to V18 Update 3, the diagnostics indicator is not visible on the HMI device.
Solution:
1. Copy the missing diagnostics indicator.
2. Compile the full project.
3. Download the full project.
4. After the full download, you can delete the copy of the diagnostics indicator.

System diagnostics control
The system diagnostics control is not supported in conjunction with an S7-1500R/H software 
controller or controller.

4.8.3 Improvements in V18 Upd. 3
This update contains the HMI device image version 18.0.0.3. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V18 Update 3 for 
configuring the HMI devices.

Improvements in WinCC Unified
4.8 Unified Comfort Panel

Readme
Readme, 10/2024, A5E52423187-AE 129



Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Diagnostics functions
The process diagnostics and system diagnostics functions for Unified PC are now also available 
for Unified Comfort Panels.

Control Panel
"Service and Commissioning" > "Trace forwarder"
Under "Trace forwarder" you can specify a storage medium and a path for saving "tracing" 
information in corresponding log files.
In addition to the information in the operating instructions, the following applies:
Log files on the selected storage medium
The log files with the "tracing" information are always saved in a subdirectory "/TraceLogs" on 
the selected storage medium.
• If no path is specified, then you will find the log files in the "/TraceLogs" directory.
• If a path is specified, then you will find the log files under "/<Path>/TraceLogs".
Names of the log files
The log files are named with date and time according to the following syntax: TraceLogs-
YYYY-MM-DD-T_HH_MM_SS.log

SVG graphics
The display of SVG graphics has been improved.

4.8.4 Improvements in V18 Upd. 2
This update contains the HMI device image version 18.0.0.2. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V18 Update 2 for 
configuring the HMI devices.

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.
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4.8.5 Improvements in V18 Upd. 1
This update contains the HMI device image version 18.0.0.1. To make use of the corresponding 
engineering and runtime improvements, we recommend using WinCC Unified V18 Update 1 for 
configuring the HMI devices.

Stability and performance
The stability and performance have been improved based, among other things, on the feedback 
received.

Control Panel
"Apps" > "SIMATIC Apps" > "SIMATIC Extensions" removed
The "SIMATIC Extensions" app has been removed, as the associated functionality is now 
available in TIA Portal.

"Runtime Properties" > "Alarm buffer" renamed "Alarm persistency"
The "Alarm buffer" function has been renamed "Alarm persistency", since this function is used 
to enable or disable the retentivity of the alarm buffer rather than the alarm buffer itself.
The associated "Enable alarm buffer" option has been renamed "Enable alarm persistency".

Central user management - automatic logoff
The value "Maximum session timeout" in the user management of the HMI device indicates the 
number of minutes after which the user is automatically logged off if he does no longer perform 
any operator action.
This value can now also be set in the central user management via the parameter "Auto 
logoff time (minutes)".
Important: Without changing the default value under "Auto logoff time (minutes)", automatic 
logoff remains deactivated for the selected user. Change the default value when using the 
parameter for the first time.

Screen change
The behavior of the screen change in connection with large plant screens has been improved.

Representation of the alarm view in the simulation
In the simulation, the display of an alarm view configured as a message line was improved, i.e. 
adapted to the display on the Panel.

Number of login attempts
The number of attempts for the correct entry of the login data can be configured in the 
engineering under "Runtime settings > Security" as of WinCC Unified V18 Update 1.
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4.9 Unified Basic Panel

4.9.1 Licensing

Licenses 
The following table shows which licenses you can configure Unified Basic Panel:

Existing 
license

Devices that can be used

  Unified Devices Classic Devices
WinCC

Unified PC
Comfort
Panels

Basic
Panels

RT Professional RT Advanced Comfort
Panels

Basic
Panels

WinCC Unified Basic ES** No No Yes No No No Yes
WinCC Unified Comfort ES No Yes Yes No No Yes Yes
WinCC Unified PC 10k ES Yes (10k*) Yes Yes No Yes Yes Yes

WinCC Unified PC 100k ES Yes 
(100k*)

Yes Yes Yes Yes Yes Yes

WinCC Unified PC max ES Yes Yes Yes Yes Yes Yes Yes
WinCC Basic No No Yes No No No Yes

WinCC Comfort No Yes Yes No No Yes Yes
WinCC Advanced Yes (10k*) Yes Yes No Yes Yes Yes

WinCC Professional 512 Yes (10k*) Yes Yes Yes (512*) Yes Yes Yes
WinCC Professional 4096 Yes (10k*) Yes Yes Yes (4096*) Yes Yes Yes
WinCC Professional max Yes 

(100k*)
Yes Yes Yes Yes Yes Yes

* Maximum possible number of PowerTags

Validity of license keys for older versions of WinCC
With a valid License Key for WinCC V18.x, you can also operate older versions of WinCC without 
restrictions.
You can find more detailed information in the following table:
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WinCC Engineering System

Edition License Valid for
WinCC Basic V18.x WinCC Basic • WinCC Basic V18.x  

• WinCC Basic V17.x
• WinCC Basic V16.x
• WinCC Basic V15.x
• WinCC Basic V14.x
• WinCC Basic V13.x
• WinCC Basic V12.x
• WinCC Basic V11.x
• WinCC Unified Basic V18.x

4.9.2 General technical specifications
The following tables of performance features help you to assess whether your project conforms 
to the system limits of a given HMI device.
The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.
Furthermore, the complexity of configuring the screens, such as the number of objects per 
screen, the number of tag connections, cycle times and scripts, has a significant influence on 
the open screen times and the performance in runtime.
In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.

Tags
  Unified Basic 4-12"
Number of tags in the project 1000
Number of elements per array 100

Alarms
  Unified Basic 4-12"
Number of alarm classes 32
Number of discrete alarms 2000
Number of analog alarms 100
Size of the alarm buffer 1) 2000
Length of an alarm in characters 512
Number of alarm texts per alarm 10
Number of process values per alarm 10
Number of queued alarm events 64
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  Unified Basic 4-12"
Number of controller alarms 160000
Number of OPC UA A&C alarms 20000

1) Corresponds to the number of all states of the messages of all configured alarm classes 
and includes the alarms of alarm classes which are not shown in an alarm control due 
to the configuration.

Number of alarms that can be displayed in an alarm control
The maximum number of alarms that can be displayed in runtime depends on the selected view.

  Unified Basic 4-12"
Show active alarms 2048
Show defined alarms 2048
Alarm statistics - view 2048
Show logged alarms 1000
Show and update logged alarms 100

Screens
  Unified Basic 4-12"
Maximum size in the Engineering System 20,000 * 20,000 pixels
Maximum size in runtime 20,000 * 20,000 pixels
Number of screens 300
Number of lower-level screen windows 10
Number of objects per screen 600
Number of objects from the "Controls" area per 
screen

5

Number of tags per screen 300

Parameter sets
  Unified Basic 4-12"
Number of parameter set types 250
Number of parameter set type elements 250
Number of parameter sets 250
Reserved memory for data records in the internal 
Flash

5 MB
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Libraries
  Unified Basic 4-12"
Number of versions of dynamic SVGs 1000 with an average size of 10 KB

Logs
  Unified Basic 4-12"
Number of logs 10
Maximum size of a log 50 MB
Maximum size of a segment 50 MB
Number of logging tags: SQLite: 50
Memory requirements of the data log  
Size of entry of logging tag The size of the entry of a logging tag is largely determined by the data type. 

Depending on the data type, the following memory requirements apply: 
• 32-bit value, e.g. Bool, Int, LReal, ... : ~ 80 byte / entry
• 64-bit value, e.g. LInt, DateTime, LTime, … ~ 106 byte / entry
• Text value (any length), e.g. WString, WChar: ~ 586 bytes/entry

Additional memory requirement of a segment: SQLite: Approx. 0.5 MB
Memory requirements of the alarm log  
Basic entry in the alarm log without alarm text: SQLite: Approx. 300 bytes
Memory requirement of the alarm text per char‐
acter and language:

SQLite: at least 1 byte

Additional memory requirement per language 
(one-off):

SQLite: Approx. 100 bytes

Trends
  Unified Basic 4-12"
Number of trends 50
Number of trends per trend control 10
Number of trend areas per trend control 2

Text lists and graphics lists
  Unified Basic 4-12"
Number of graphics lists 100
Number of text lists 300
Number of entries per text or graphics list 250
Number of graphic objects 500
Number of text elements 2500
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Scripts
  Unified Basic 4-12"
Number of scripts 50
Number of functions per function list 25

Scheduler
  Unified Basic 4-12"
Number of tasks, time- or event-triggered 10

Communication
  Unified Basic 4-12"
Number of S7 connections 8

Reporting
Reporting on Unified Basic Panels is currently not supported.

OPC UA
  Unified Basic 4-12"
Number of connected OPC UA clients Unified Basic Panels can currently only be used as an OPC UA client
Maximum address length of OPC UA server vari‐
ables for addressing by a Unified OPC UA Client 

256 characters

Languages
  Unified Basic 4-12"
Number of runtime languages 32

User management
  Unified Basic 4-12"
Number of roles 50
Number of predefined function rights 20
Number of users 200
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Project
  Unified Basic 4-12"
Size of the project files on the device < 50 MB

4.9.3 Unsupported functions
The following tables show which functions are currently not supported on a Unified Basic Panel.

Screen objects
• f(x) trend control
• Trend companion
• Media player
• Custom Web Controls
• Plant overviews

Screen objects with limited functionality
In conjunction with HMI device image version 18.0.0.3, the following applies: The "Print" button 
is not supported for the trend control.

System functions
The following system functions can be configured in the engineering system, but are not 
supported by Unified Basic Panel in conjunction with HMI device image version 18.0.0.3.
• Create screenshot

Runtime functions
• Audit
• Reporting
• Runtime Collaboration

Connectivity
Unified Basic Panels can only be used as OPC UA clients and not as OPC UA servers.
Unified Basic Panels can only be used as SmartClient and not as SmartServer.
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Notes on TIA Portal Openness 5
This update contains the following improvements and changes:

Exporting and importing CAx data via TIA Portal Openness
In the documentation for TIA Portal Openness V18 it was announced that support for exporting/
importing CAx data will be discontinued as of V19. Please note that with V19 only support for 
exporting/importing via command line is discontinued. Importing/exporting of CAx data via TIA 
Portal Openness will continue to be possible.

IO-Link port
As of TIA Portal V18 Update 2, the IO-Link port with the designation 'C/Q<n>' will be replaced. 
Here the port number is <n>. Example: Example: C/Q1, C/Q2
For AML replacement of the IO-Link configuration via S7-PCT as of TIA Portal V18 Update 2, 
use the version "S7-PCT 3.5 SP3 Update 3" or higher.

Creating objects for WinCC Unified devices 
When creating objects in screens for WinCC Unified devices via TIA Portal Openness, the size and 
position specifications defined in a style are correctly taken into account.
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